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Introduction

AccuRev proudly introduces AccuRev Version 6.2, helping you unleash the power of software
development teams to deliver superior results. AccuRev 6.2 contains new features designed to increase
productivity among software development teams, including the use of gated streams to specify conditions
for promoting changes based on external criteria, as well as the ability to demote issues, transactions, and
files. Along with these and other improvements to the GUI, AccuRev 6.2 provides humerous
enhancements to the command line interface and user documentation, as well as other changes based on
feedback from our users.

Highlights of this Release

Highlights of the exciting developments in AccuRev 6.2 are captured here.

New: Gated Streams

AccuRev 6.2 introduces a new stream type -- gated streams. A gated stream uses user-defined rules to
control whether changes promoted into the stream are promoted out of it. These rules can be based on
meeting externally established criteria -- like passing a test suite or successfully completing a build, for
example. You can use gated streams with triggers and with the StreamBrowser's streamCustomicon
introduced in AccuRev 6.1 to provide at-a-glance status of the effect of your most recent changes.

You can create gated streams in the AccuRev GUI and in the AccuRev CLI (mkstream --gated). Setting up
and using gated streams is described in Chapter 11, Using Streams to Enforce Process, of the AccuRev
Administrator’s Guide.

New: Demote

New for AccuRev 6.2 is the ability to demote changes that have been promoted to a stream. The demote
operation allows you to "undo™ changes in the same ways in which you can promote them:

= By element
= By transaction
= By issue (change package)

As with promote, the new demote operation can be performed in both the AccuRev GUI and the command
line interface (CLI). For more information, see the CLI reference documentation and the section called
Demote: Moving Elements Out of a Stream, in Chapter 3, The File Browser, of the AccuRev Online Help.

New: File Browser preferences are saved

If a user selects or clears the Include/Exclude or Deep Overlap Optimization check boxes in the File
Browser, AccuRev retains the choice in the preferences.xml file. The next time the user opens a stream or
workspace, the saved settings are applied.

AccuRev® Installation and Release Notes 1



New: ACCUREV_SERVER environment variable

A new ACCUREV_SERVER environment variable dictates the AccuRev Server that the AccuRev GUI
interacts with when the GUI is started. See the CLI reference documentation for more information.

New CLI Commands and Options

The AccuRev command line interface (CLI) has the following new commands and options.

New demote CLI Command

The demote command provides users with the ability to remove changes that have been promoted to a
stream while still retaining those changes in a child stream or workspace. The demote command allows
you to "undo™ changes in the same ways in which you can promote them: by issue, transaction, or file.
Users can also perform demote operations through the GUI.

New rebase CLI Command

The rebase command purges elements in your default group when you want to allow inheritance, resolve
underlaps, or purge stranded elements. In addition, a new --rebase option has also been added to the purge
command. See the CLI reference documentation for more information.

New Option for the mkstream Command

The mkstream command has a new --gated option. This option specifies that the new stream is a gated
stream. A gated stream is a stream that you use to control whether changes promoted into it are
automatically promoted out of it, often based on meeting externally established criteria (such as passing a
test suite or completing a successful nightly build, for example). See Chapter 8, "Using Streams to Support
Continuous Integration" in the AccuRev Administrator’s Guide for more information on gated streams.

New Option for the stat Command

The stat command shows the AccuRev status of elements or file system objects. Users can now select a
file element by using the -e command to specify the element-ID (eid). The ability to stat elements by eid,
rather than by specifying the name of the element, is useful for certain operations, such as tracking down
stranded elements.

New Reserved Stream Property for the setproperty Command

A new reserved stream property, stagingStreamResult, has been added to the setproperty command. You
can use stagingStreamResult to manually override the status on a staging stream.

See the CLI documentation (AccuRev CLI User’s Guide or CLI help) for more information.

Deprecated Features and Platforms

The following features are no longer supported in AccuRev 6.2:

= Starting with AccuRev 6.2, the Client-only Package Download Utility is no longer available, and
administrators no longer have the ability to download client-only packages as part of the full AccuRev
installation. AccuRev users will still be able to use the Upgrade Client feature provided the client-only
packages are accessible on the AccuRev Server. See Using Client-only Install Packages for more
information.

= AccuRev version 6.2 does not support the HP-UX platform.
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AccuRev Installation Notes

This chapter describes how to install and upgrade AccuRev 6.2 software at your site. In addition to
installation procedures, it provides information about installation package options, considerations for
upgrading, and post-installation procedures. AccuRev 6.2 is intended for new customers, and for all
existing customers who wish to upgrade to the latest AccuRev release.

This chapter is intended for the AccuRev administrator responsible for installing and upgrading AccuRev.
Users responsible for installing or upgrading their individual AccuRev Client installations will probably be
most interested in the material discussed in Installing or Upgrading an AccuRev Client on page 19.

Compatibility with Previous Versions

AccuRev 6.2 is not compatible with previous versions of AccuRev -- 6.2 AccuRev Clients will only work
with the 6.2 AccuRev Server, and the 6.2 AccuRev Server does not support existing (6.1 and earlier)
AccuRev Clients.

For a high level summary of new features in Release 6.2, see Highlights of this Release on page 1. For a
detailed list of changes, see AccuRev 6.2 Release Notes on page 61.

Installation Overview

Generally speaking, installing AccuRev involves downloading an installation package from the Micro
Focus Web site and running it on the target machines at your site. One machine should be designated as the
AccuRev Server machine -- the one that runs the AccuRev Server process, the Web Ul Server process, and
hosts the AccuRev data repository. This machine can also optionally host the Reprise License Manager
(RLM) Server process. Other machines can access the AccuRev Server after you install the AccuRev
Client software on them.

You can also have one or more replica servers in your environment. AccuRev replica servers enable you to
provide access to remote users spread across multiple geographic sites. Replication can also enable you to
distribute the load off a single server.

Installation Packages

AccuRev provides two installation packages: the AccuRev installation package, and the AccuRev Client-
only installation package.

= The AccuRev installation package lets you install either:

= The AccuRev Server and Web Ul Server. The AccuRev Server and AccuRev Web Ul Server
installation is the correct choice for a new customer setting up the AccuRev infrastructure for the
first time. During the installation of the AccuRev Server and Web Ul Server, you can also
optionally download AccuRev Client-only installation packages for your desired platforms. These
client-only installation packages can then be used by your system’s users to upgrade existing
clients for AccuRev 5.5 and higher.

AccuRev® Installation and Release Notes 3



= The AccuRev Web Ul Server only. As the name suggests, the AccuRev Web Ul Server only
installation is appropriate for users who wish to install only the AccuRev Web UI.

Both installation types can be used to install AccuRev components for the first time, or to upgrade
existing AccuRev components. They can be run in either graphical (GUI) or text-based (console)
interactive modes.

Note: The AccuRev installation package recently added several enhancements and new features. If
you are an existing AccuRev customer, you might be interested in the information in Recent Changes
to the Installation Wizards on page 4.

» The AccuRev Client-only installation package lets you install or upgrade just the AccuRev
Client. The client-only installation is useful if you just need to perform a simple client installation to
use with an existing, up-to-date AccuRev Server. In addition to graphical (GUI) and text-based
(console) interactive install modes, the Client-only installation package also supports a "silent" install
mode. The "silent" install requires the presence of a response file, which contains a record of responses
to prompts from an earlier installation. See Using Silent'Client Installations on page 23 for more
information.

If you are installing the AccuRev Client for the first time, or if you are upgrading from a previous
version of AccuRev, you must download the AccuRev Client-only installation package for your
client’s platform from the Micro Focus SupportLine download page.

If you are upgrading an existing client from AccuRev 5.5 or higher, however, consider using the
Upgrade Client feature. See Installing or Upgrading an AccuRev Client on page 19 for more
information.

AccuRev and AccuRev Client-only installation packages are available on the Micro Focus SupportLine
page (http://supportline.microfocus.com/).

The Mosquitto MQTT Message Broker

AccuRev Version 6.2 supports Message Queue Telemetry Transport (MQTT) message broker
communications. By using an MQTT message broker, the AccuRev GUI client can automatically receive
messages about dynamic changes occurring in Gated Streams from the AccuRev Server.

As of AccuRev 6.2, the Mosquitto MQTT message broker is automatically installed on Windows, Linux,
and Solaris platforms so that the AccuRev server can update the AccuRev client with changes from the
AccuRev server.

In a Windows environment, the Mosquitto message broker runs as a new service. By default, AccuRev
attempts to access port number 1883 to use this message broker. If this port number is already in use or if
your firewall denies access, the Mosquitto message broker does not work and the AccuRev GUI client has
to be refreshed manually.

Installation Wizards

AccuRev Installation Wizards guide you through the AccuRev installation process. The Installation
Wizard can be run in either a graphical (GUI) or text-based (console) mode.

Recent Changes to the Installation Wizards

If you are upgrading from an older release of AccuRev, you might notice the following new features or
changes in the Installation Wizards.
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= Starting with AccuRev 6.2, the Client-only Package Download Utility is no longer available, and
administrators no longer have the ability to download client-only packages as part of the full AccuRev
installation. AccuRev users will still be able to use the Upgrade Client feature provided that the client-
only packages are accessible on the AccuRev Server.

= On 64-bit Linux (x86) or Windows (x86) systems, accepting the default settings installs the 64-bit
AccuRev Server and Client. You also have the option to install a 32-bit version of AccuRev Server and
Client on 64-bit Linux, or Windows systems. (See Table 5 on page 8 for limitations for non-Windows
upgrades.)

= Users installing on Windows may notice a "Checking for necessary Microsoft DLLs" message. The
installer ensures that you have a current copy of the Microsoft Visual C++ Redistributable Package
installed.

Post-installation Administrative Scripts

AccuRev installation packages provide the ability to invoke a script or executable. To configure this
feature you simply set environment variable ACCUREV_POST_INSTALL to the fully-qualified path of
the script or executable. The AccuRev installer will execute that script as the last step of the installation
process.

Preparing for Installation

This section describes the steps to take to prepare for installing AccuRev 6.2, as summarized in the
following table.

Table 1. Preparing to Install AccuRev

Step Action Comments

1 Get an AccuRev License You do not need a license to install just the AccuRev Client
or the AccuRev Web Ul Server.

2 Determine Configurable Elements The installation instructions use generic names. Refer to
this section to determine values appropriate for your site
prior to installation.

3 Download the Installation Packages If you are installing just the AccuRev Client, check with
your AccuRev administrator to see if the Upgrade Client
feature is available at your site.

Get an AccuRev License

In order to install AccuRev 6.2, you need an accurev.lic license file, which is required by the Reprise
License Manager that is installed with AccuRev. You do not need an accurev.lic license file to install the
AccuRev Web Ul Server or AccuRev Client.
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The process for getting an accurev.lic license file varies based on several factors, including your current
license type and whether or not you are currently under maintenance, as summarized in the following table.

Table 2. Getting an AccuRev License

UEe O.f . T Procedure Comments
Installation License Type

New n/a Use the License Request form at http:// | None
supportline.microfocus.com/licensing/
AccuRevLicensing.aspx to get a license
for any new AccuRev installation.

Upgrade keys.txt If you are currently under maintenance, | To determine whether or not you are
use the License Request form at http:// | still under maintenance, check the
supportline.microfocus.com/licensing/ | second date in the keys.txt file.
AccuRevLicensing.aspx to get a new
AccuRev license. Note: Use the AccuRev CLI command

hostinfo to obtain the name of the
If you are not currently under License Manager host machine (Host
maintenance, contact a representative | Name) required by the License
at sales@accurev.com. Request form.

Upgrade accurev.lic Determine if your AccuRev To determine if your maintenance is
maintenance is current or expired. If current or expired, check the
your maintenace is: maintenance expiration date shown in
= Current, you can use it to install each license section as replace

AccuRev 6.2 options=<date>.
= Expired, contact a representative at
sales@accurev.com.

Note: As of AccuRev 5.5, separate test licenses are no longer required. For example, if you are
installing a trial server on a test machine before upgrading your production servers, you can obtain a
license from your RLM server. For more information on this topic, see “Multiple AccuRev Servers” in
the AccuRev Administrator’s Guide.

Determine Configurable Elements

The installation and setup process involves a number of configurable elements. For simplicity and clarity,
the instructions consistently use a set of generic names, using <thais font>. \When you see a generic name
in a procedure, you must replace that name with the value that is appropriate for your site. For example,
you might replace <ac-install>with C:\Program Files\AccuRev.

Tip: Use the Name at Your Site column in the following table to record the names you plan to use.

Table 3. Generic and actual names used during installation

Generic Name Name at Your Site Description
<installer-/Joc> Location of the downloaded AccuRev installation package.
<ac-install> Location that AccuRev is installed to. Defaults to:

= (Windows) C:\Program Files\AccuRev (32-bit) or
C:\Program Files (x86)\AccuRev (64-bit)
= (UNIX/Linux) <homeDirectory>/accurev

<ac-storage> Location of the AccuRev database and container files. Defaults to:

= (Windows) C:\Program Files\AccuRev\storage (32-bit) or
C:\Program Files (x86)\AccuRev (64-bit)

® (UNIX/Linux) <homeDirectory>/accurev/storage
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Generic Name Name at Your Site Description

<ac-host> Hostname of the AccuRev Server.

<ac-port> Port number that the AccuRev Server runs on. Defaults to 5050.

<ac-user> Name of the operating-system user that runs the AccuRev Server.
Defaults to: acserver.

<ac-pass> Password for <ac-user>.

<db-porit> Port number that the database server runs on. Defaults to 5075.

<db-admin-name> Name of the database superuser. Defaults to postgres.

Note: AccuRev recommends that you retain the default value,
postgres. If you create a different value for the database superuser, it
must be lowercase.

<db-admin-pass> Password for <db-admin-name>.
Note: The database password must be lowercase.

Download the Installation Packages

On the Micro Focus supportline page
(http://supportline.microfocus.com/websync/productupdatessearch.aspx), download the appropriate
AccuRev installation package for your operating system to a local directory (referred to as <installer-
Joc> throughout this document).

Users can install AccuRev by downloading the AccuRev installation package to the client machine and
manually running the installation package executable. Users can also start the installation automatically by
selecting Help > Upgrade Client in the GUI or by using the accurev upgrade_client in the CLI, if
someone (typically, the system administrator) has already downloaded the installation package to the
AccuRev server, copied it to the appropriate location, and renamed it as described in Enabling the Client
Upgrade feature on page 21.

If you download a compressed package (.zip or .gz file), first extract the files from the package before
continuing. Many extraction tools are freely available and the unzip and gunzip programs are standard on
many UNIX/Linux systems. The Mac OS X operating system does not require any special software for .zip
files -- just double-click the file to extract its contents.

What to Do Next

What to do next depends on whether you are installing or upgrading AccuRev, the AccuRev Client, or the
AccuRev Web Ul Server, as summarized in the following table.

Table 4. Next Steps in the Installation Process

If You Are Installing or Upgrading Go To
The AccuRev Server Installing or Upgrading an AccuRev Server on page 8
Just the AccuRev Client Installing or Upgrading an AccuRev Client on page 19
Just the AccuRev Web Ul Server Installing or Updating the AccuRev Web Ul Server on page 26
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Installing or Upgrading an AccuRev Server

The procedure for installing AccuRev is largely the same whether you are installing AccuRev for the first
time or you are upgrading an existing AccuRev installation. Note, however, that there are several important
considerations and prerequisites for users upgrading to AccuRev 6.2. See Upgrade Paths to AccuRev 6.2
on page 15 for more information on this topic.

Before You Begin

Whether you are performing a new AccuRev Server installation or upgrading an existing installation,
before installing AccuRev 6.2 you should:

1. Read the Platform Support Notes on page 39 for your operating system before proceeding, and follow
the instructions there.

2. Check the Known Issues on page 79 for any issues that might apply to your site.

3. Ifyou are installing a new AccuRev Server on a UNIX/Linux machine, run the adduser command to
make an OS-level user (<ac-user>). You should set <ac-instafI>as the home directory for this user.
The AccuRev Server cannot be installed by root on UNIX/Linux platforms.

4. Acquire an accurev.lic license file if you have not already done so. See Get an AccuRev License on
page 5 for more information.

Note: You must have an accurev.lic file in order to install AccuRev 6.2.
5. If you are upgrading an existing AccuRev Server:

= IMPORTANT: Perform a full backup of your AccuRev data. This includes backing up any
replica servers. For detailed instructions, see the section titled “Backing Up the Repository” in the
AccuRev Administrator’s Guide for your existing release. MAKE SURE TO USE THE
CORRECT BACK UP PROCEDURES FOR YOUR EXISTING INSTALLATION. (In other
words, do not use the back up procedures documented in the new 6.2 Administrator's Guide to
back up your 4.x data.)

= Read through the upgrade information that applies to your current AccuRev installation in Server
and Database Upgrades on page 15 before you start the installation process.

= Plan a maintenance window for this upgrade and data migration, during which clients will not be
able to connect to the server. See the instructions at Upgrading a Replica Server on page 19 for
running a trial upgrade and estimating the time to complete the process.

= If you plan to change from 32-bit to 64-bit, or from 64-bit to 32-bit, as part of your upgrade, use
the following table to confirm that you can do so:

Table 5. Changing from 32-bit to 64-bit, or from 64-bit to 32-bit, as part of upgrade

Platform Supported for Upgrades from 4.x Supported for Upgrades from 5.x
Windows Yes Yes
Solaris/Linux Yes NO -- If you wish to change between 32- and 64-bit

when performing the upgrade, please contact
AccuRev Support Services (http://
accurev.force.com/customerportal) for procedures.
See SunOS / Solaris on page 42 for more
information.
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6. Before starting the installation on UNIX/Linux, ensure that the LC_ALL environment variable is set to
a UTF-8 locale (such as "en_US.UTF-8", NOT "en_US.latin".) Windows installations are not affected,
however proceeding with a non UTF-8 locale on UNIX/Linux can lead to a failed, partially-complete
installation. Use the locale command to determine your current locale setting, and locale -a to
determine what locales are available. See the documentation for your operating system for details
about how to install and change locale settings.

Considerations for AccuRev Replication Servers

Before deciding to install a replica server, see the "Replication of the AccuRev Repository" and "License
Management" chapters in the 6.2 AccuRev Administrator’s Guide. Before proceeding with replica server
installation, contact AccuRev Support Services (http://accurev.force.com/customerportal) for more
information.

Use Native Shells

AccuRev recommends using only shells that are native to/installed with the OS. Avoid using a third-party
shells as they do not always work as expected.

Running the AccuRev Installation Wizard

This section describes how to run the AccuRev Installation Wizard. It assumes you have already
downloaded the correct installation package for your platform as described in Download the Installation
Packages on page 7.

Overview

The AccuRev wizard guides you through steps for installing a new AccuRev Server or upgrading an
existing server. If the Installation Wizard discovers that an AccuRev server already exists in the location
you specify, it will prompt you through the upgrade process.

Upgrading to 6.2 from AccuRev 5.4.1 or earlier requires a database upgrade, independent of the
installation process. The complexity of the database upgrade depends on the release from which you are
upgrading. See Server and Database Upgrades on page 15 for more information.

If the Installation Wizard determines that you have an existing, nonstandard 5.x database installation (for
example, if you installed your own copy of PostgreSQL, or you have multiple instances running on the
same machine), the installer will not continue. Nonstandard database installations are not supported. You
need to contact AccuRev Support Services (http://accurev.force.com/customerportal) to continue.

At the end of the installation, make sure that you tune your database parameters as described in
Configuring Database Tuning Parameters on page 30. You must reboot the database for the tuning
parameters to take effect.

Before You Begin
Before running the AccuRev Installation Wizard:
1. Login-- Log in to the machine on which you will be installing AccuRev. Log in as <ac-user>

(UNIX/Linux) or a user with installation privileges (Windows). (See Before You Begin on page 8 to
learn about creating <ac-user>on UNIX/Linux machines.)

Note: For security reasons, you CANNOT install the AccuRev server on UNIX/Linux if you are
logged in as root.
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2. Stop the AccuRev Server and AccuRev DB Server -- If you are upgrading an existing AccuRev
Server, you must stop the AccuRev Server and the AccuRev DB Server before you can install the
current version. See Starting and Stopping AccuRev Servers on page 37 if you need help with this step.

Tip: Stopping the AccuRev DB Server also stops the AccuRev Server.

How to Run the AccuRev Installation Wizard
This section describes how to install AccuRev using the AccuRev Installation Wizard.

Note: The specific prompts that you see and the order in which you see them can vary depending on
your particular installation and the options that you select. All users will not see all the prompts
described in the following procedure, which focuses on the graphical version of the Installation Wizard
but provides information about console mode in [brackets].

To run the AccuRev Installation Wizard:

1. Start the Installation Wizard -- Start the AccuRev Installation Wizard you downloaded from the
Micro Focus web site by double-clicking the installer icon, or by entering the installer name on the
command line as summarized in the following table. Note that the installation program can be run with
a graphical user interface (GUI) or as a console (text-only) application.

Table 6. Starting the AccuRev Installation Wizard

Platform Installation Mode Run This Procedure

Windows GUI accurev-n.n.n-windows-clientonly.exe
where _n_n_n is the AccuRev version number
accurev-6.2.0-windows-clientonly.exe, for example

Console (text-based) accurev-n.n.n-windows.exe -i console
where _n_n_n is the AccuRev version number
accurev-6.2.0-windows.exe -i console, for example

UNIX/Linux GUI sh accurev-n.n.n-platform-clientonly.bin
where:

® -n.n.n is the AccuRev version number

= platform is the UNIX/Linux platform name
sh accurev-6.2.0-linux-x86-clientonly.bin, for example

Console (text-based) sh accurev-n.n.n-platform.bin - i console
where:

" _n.n.n is the AccuRev version number

= platform is the UNIX/Linux platform name
sh accurev-6.2.0-linux-x86.bin - i console, for example

Tip: If you are installing AccuRev from the console you can type:
= "back" to return to the previous prompt in the installation program
= "quit" to exit the installation program

2. License Agreement -- Before you can proceed, you must click “I accept the terms of the license
agreement.” and then click Next to continue. [Console: You can type ¥'to agree, h'to refuse, or
press Enter to page through the license agreement.]

3. Confirm Administrator Privileges -- If the installer prompts you for this information:

= Windows: Specify whether or not the current user has Administrator privileges on the current
machine. Note that Windows requires that you have Administrator privileges.
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= UNIX/Linux: Specify whether the current user is root. Note that for security reasons, you
CANNOT install the AccuRev server on UNIX/Linux if you are logged in as root.

4. Choose Install Folder -- Specify a different directory if you do not want to use the <ac-install>
defaults: <homeDirectory>/accurev on UNIX/Linux, C:\Program Files\AccuRev on Windows.
See Determine Configurable Elements on page 6 if you are not familiar with the values represented by
<ac-install> and <homeDirectory>.

= Ifyou are installing software for the first time, and do not wish to use the default location, specify
a location where you have write permission.

= If you are upgrading and the existing installation is not at the default location, specify your
existing AccuRev installation directory.

Click Next to accept the default and continue. [Console: Press Enter to accept the default and
continue.]

5. Choose Installation Type -- Select one of the following:

= AccuRev Server and Web Ul Server -- Installs the AccuRev Server, the AccuRev Web Ul
Server, and a local AccuRev Client. Note that the AccuRev Web Ul Server includes an Apache
Tomcat web server. [Console: Press Enter to install the AccuRev Server and Web Ul Server.]

= Web Ul Server only -- Installs only the AccuRev Web Ul Server and AccuRev Client. If you
choose this installation option, click Next and go to Installing or Upgrading an AccuRev Client on
page 19 to complete the installation. [Console: Type 2"and press Enter to install the Web Ul
Server only.]

6. Install Replication [Console: “Choose Replication Type”] -- Choose No replication [Console: “1”
for None] unless you have already determined (along with AccuRev Support Services) that your site
will be implementing one or more replica servers. If you have any questions about AccuRev
replication servers, refer to Considerations for AccuRev Replication Servers on page 9 before
continuing.

If you know for a fact that your site is implementing replica servers, select either:

= “Yes, this is the master” for the site that will be sending elements out to the replica [Console: type
2'for Master.]

= “Yes, this is a replica” for the site (typically remote) that will be connecting to a master server to
receive files [Console: type 3'for Replica.]

Proceed through the remainder of the installation program. When prompted for replication options,
confirm your choice of master server or replica server as appropriate.

To upgrade an existing replica server, see Upgrading a Replica Server on page 19.

Note: Installing the replica software is only part of the process. Before you can use a newly-installed
replica server, you need to configure both it and the master server. Configuration and licensing
information about replica servers is located in the “Replication of the AccuRev Repository” and
“License Management” chapters in the AccuRev Administrator’s Guide.

7. Customize: Choose a Folder for AccuRev Server Data Storage [Console: “Choose a Folder for
AccuRev Server Data Storage™.] -- If you do not want to use the <ac-storage> default
(<homeDirectory>/accurev/storage on Linux/UNIX, C:\Program Files
(x86)\AccuRev\storage on Windows), specify a different directory in the Please Choose a Folder
field. AccuRev creates the folder you specify if it does not already exist.
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10.

11.

Note: Ensure that the path you specify is LOCAL disk storage (not a network drive) and that it has
plenty of space.

Click Next to continue. [Console: Press Enter.]

Configure Database Port and User -- Enter the values for the Database Port (<db-pore>) and
Superuser Name (<ab-admin-name>) fields. [Console: Prompts for these values individually.]

Unless the default database port "5075" conflicts with something else on your machine, you should not
change the value in the Database Port field. Likewise, AccuRev recommends that you keep the
default value "postgres"” for the Superuser Name unless you have a specific reason to change it.

Note: If you create a different value for the database superuser, it must be lowercase.

Configure Database Password [Console: ““Set Database Superuser Password™.] -- In the Superuser
Password field, enter the value for <db-admin-pass>that you chose in Table 3 on page 6. Enter it
again in the Confirm Superuser Password field. Make sure that you record this password in a secure
location for later use.

Note: The database password must be lowercase.

License Server Host -- Specify whether you are using the machine on which you are installing
AccuRev as the host for your Reprise License Manager (RLM), or whether you are using an existing
RLM on another machine:

= Local AccuRev License Manager -- Choose this option unless you have an existing RLM on
another machine that you want to use. Later in the installation (Step 13) you will specify
configuration settings for the RLM. [Console: Type 1'for Local.]

= Remote AccuRev License Manager -- If you DO have an existing RLM on another machine that
you want to use, choose this option. [Console: type 2'for Remote.] If you choose this option, the
Installation Wizard displays an additional page, AccuRev License Manager Configuration,
which requires that you enter the following:

= Hostname -- Enter the network name of the server where the remote RLM exists.

= Port -- Keep the default value of 2375, unless you know that the remote RLM is running on a
different port.

For more information about licensing, see the following:
= The “License Management” chapter in the AccuRev Administrator’s Guide.

= Anexample script for automatically starting the RLM server at boot time on UNIX/Linux systems

(automatically done for Windows installations):
<ac-install>/extras/unix/accurev_rlIm

= “The License Server” section of the on-line RLM License Administration Manual at
http://www.reprisesoftware.com/RLM_Enduser.html

Note: As of this writing, the RLM License Administration Manual describes the features and
functionality supported by the RLM server that is currently installed with AccuRev (RLM version
10.1). As RLM documentation is not installed with the RLM server (rather, it is hosted on the
RLM web site), be aware that the available RLM documentation might not always match the
version of your RLM server.

Install New AccuRev License? -- If the Installation Wizard detects an existing accurev.lic license file
where you have chosen to install AccuReyv, it gives you the choice to continue using that license or to
specify a different accurev.lic file.

12
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12.

13.

14.

15.

16.

17.

18.

19.

20.

To use the existing license, choose No, click Next to continue [Console: Type h'and press Enter to
continue.], and go to Step 13.

To use a new license, choose Yes, click Next to continue [Console: Type h'and press Enter to
continue.], and go to Step 12.

Specify AccuRev License Location -- Specify the full path of your accurev.lic license file. See
Enabling the Reprise License Manager (RLM) on page 38 for more information.

AccuRev License Manager Configuration -- Use this page to confirm default settings for the
Reprise License Manager port and web port settings. Click Next to continue. [Console: Press Enter to
continue; there are separate prompts for RLM port and RLM Web port numbers.]

Configure: Set Host and Port [Console: Choose Hostname and Port number] -- Review the default
values for the Host and Port fields for the AccuRev Server. You should accept the default values
chosen by the Installation Wizard unless you have a good reason to change them. [Console: Review
the host name value, then press Enter to continue; then review the port value and press Enter to
continue.]

Click Next to continue. [Console: Press Enter to continue.]

Adjust System PATH Variable -- Responding Yes enables the AccuRev Installation Wizard to
modify the PATH environment variable on your system so that you do not need to specify a full path on
the command line when using AccuRev commands. Click Install to continue. [Console: Type §"and
press Enter to continue.]

Note: You might need to reboot after installation before changes to the PATH environment variable
take effect.

64-bit Hardware Detected -- If the AccuRev Installation Wizard determines that you are installing on
64-bit x86 hardware running a 64-bit Linux, Solaris, or Windows operating system, it offers you the
option of installing either a 32- or 64-bit version of the AccuRev Server. In all other situations, it
installs the 32-bit version by default. (IMPORTANT: See Table 5 on page 8 for limitations.)
Optionally change the value and click Next to continue. [Console: Type 1'for 32-bit or 2'for 64-bit
and press Enter to continue.]

Note: On 64-bit Linux and Windows, the AccuRev installer ALWAYS installs a 32-bit Java
runtime environment (JRE) for use by AccuRev. This means that even if you choose to install 64-
bit AccuRev on Linux, the Linux 32-bit compatibility libraries must always be installed. If this is
not the case, the AccuRev installation will fail. See Platform Support Notes, Linux on page 39 for
more information.

Installing AccuRev -- The Installation Wizard displays a splash screen [Console: displays Installing™
with a progress bar] while it installs the software on your local machine. It displays a Please Wait
message while it performs configuration tasks.

Database Tuning -- The Installation Wizard reminds you that you can use database tuning parameters
to improve performance. See Configuring Database Tuning Parameters on page 30 for more
information. Click Next to continue. [Console: Press Enter to continue.]

Reminder -- If you are upgrading from AccuRev 5.4.1 or higher, the Installation Wizard reminds you
to run maintain dbupgrade to migrate to the current database version installed with AccuRev 6.2.
Click Next to continue. [Console: Press Enter to continue.]

Configure: Start AccuRev WebUI Server -- In a new installation, the Installation Wizard prompts
you to start the AccuRev Web Ul Server. Accept the default value (Yes) unless you want to start it
later. Click Next to continue. [Console: Press Enter to continue.]
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21.

22,

Note: See Installing or Upgrading an AccuRev Client on page 19 for more information on Web Ul
Server installation and configuration.

Configure: Start AccuRev Server -- In a new installation, the Installation Wizard prompts you to

start the AccuRev Server. Accept the default value (Yes) unless you want to start it later. Click Next to
continue. [Console: Press Enter to continue.]

Note: See Starting and Stopping AccuRev Servers on page 37 if you choose to start the AccuRev

Server at a later time.

Click Next to continue [Console: Press Enter to continue.].

To exit, click Done. [Console: Press Enter.]

What to Do Next

What to do after a successful AccuRev installation depends on whether you performed a new installation
or an upgrade, as summarized in the following table:

Table 7. Upgrading to AccuRev 6.2

Install Complete -- The Installation Wizard displays a message when the installation is complete.

Installation Type

Next Steps

For More Information

New If you chose not to start the AccuRev Server as See Starting and Stopping AccuRev
part of the installation process, you must start it Servers on page 37
before you can use AccuRev.
If you plan to make the AccuRev Web Ul available
to your users, you must:
= Start the Web Ul Server if you chose not to start | Go to Starting, Stopping, and Testing the
it as part of the installation process AccuRev Web Ul Server on page 29
= Configure the Web Ul for use with the Go to Configuring the AccuRev Web Ul
AccuRev GUI on page 29
Upgrade After upgrading to AccuRev 6.2, you need to: Go to:

® Run the maintain dbupgrade command to
migrate your database to the current version
installed with AccuRev

= Start the AccuRev Server

= Using the ‘maintain dbupgrade’
Command on page 32

= Starting and Stopping AccuRev
Servers on page 37
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Server and Database Upgrades

This section contains instructions for upgrading AccuRev databases from previous releases to 6.2. Note
that if you have existing replica servers, you must also follow the instructions in Upgrading a Replica
Server on page 19. AccuRev strongly recommends that you first perform database upgrades in "trial mode"
before attempting the actual upgrade on a production server, to determine if you will encounter any issues,
and to estimate how long the upgrade is likely to take so that you will know how long your servers will be
unavailable to your users.

Upgrade Paths to AccuRev 6.2

This section summarizes the supported upgrade paths to AccuRev 6.2 from previous versions of AccuRev.
More detailed information is presented in the following sections.

AccuRev supports upgrades from existing 4.x and 5.x. installations. Since AccuRev 5.0 introduced a third-
party database, upgrading from a pre-5.0 version of AccuRev has special requirements and procedures.
Upgrades from 5.0.x, 5.1, 5.2, or 5.3 also require a database upgrade, although these are much quicker.
The following table summarizes upgrade requirements.

Table 8. Upgrading to AccuRev 6.2

If you are up_gradlng You must: Notes
from:
pre-4.7 1. First perform an upgrade installation to 4.7.x, You cannot directly upgrade to any 5.x or
4.8.x, or 4.9.x. 6.x release from a version prior to 4.7.
2. Upgrade to 6.2 and run maintain dbupgrade.
4.7.x,4.8.x,4.9.x Perform an upgrade installation to 6.2, tune the Since 5.0 introduced a new third-party
database, and run maintain dbupgrade. database, plan sufficient time and disk
space for the dbupgrade process to
convert your existing data.
5.0.x (not including 5.0.5) Perform an upgrade installation to 6.2 and run 5.0.x uses an older version of
maintain dbupgrade. PostgreSQL than is required by AccuRev
6.2. The AccuRev installer will prompt
you through the procedure.
Note: 5.0.5 is a Japanese-localized
version of AccuRev and must be updated
to 5.2.1 (not 5.2 or 5.3 or higher).
5.1,5.2,0r5.3 Perform an upgrade installation to 6.2 and run Since 5.1, 5.2, and 5.3 are already based
maintain dbupgrade. on the third-party database, the
dbupgrade process is relatively quick.
Note: 5.2.1 is a Japanese-localized
version of AccuRev and cannot currently
be updated to 6.2.
5.4 or higher Perform an upgrade installation to 6.2 and run Note: 5.6.1 is a Japanese-localized
maintain dbupgrade. version of AccuRev and cannot currently
be updated to 6.2.

Additional Notes:

= |If you are using AccuWorkflow in AccuRev 5.4 or earlier, please contact AccuRev Support
Services (http://accurev.force.com/customerportal). This note applies only to AccuWorkflow, not
AccuWork.
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= When upgrading from all previous releases, the 6.2 AccuRev Server will not start until after you
have run maintain dbupgrade. Customers using change packages may find longer than normal
upgrade times due to the migration of the change package data models required by the 6.0 release.

= If you are upgrading an existing installation and plan to change from 32-bit to 64-bit, or from 64-
bit to 32-bit, as part of the upgrade, see Table 5 on page 8 to confirm whether this requires
assistance from AccuRev Support Services.

Upgrading an AccuRev Server from pre-4.7

If you have an existing AccuRev server that is older than 4.7, you must first upgrade to 4.7.x, 4.8.x, or
4.9.x. Make sure that you have performed the necessary steps from Before You Begin on page 8.

Before you begin, make arrangements to upgrade any scripts you have created to back up and restore
AccuRev data. Refer to the chapter titled “The AccuRev Repository” in the AccuRev Administrator’s
Guide, and the documentation for the backup command in the AccuRev CLI User’s Guide.

Download one of these releases and follow the upgrade procedures documented in the appropriate
AccuRev Installation and Release Notes document: 4.7.x, 4.8.x, or 4.9.Xx.

Once you have done this, proceed to the next section (Upgrading an AccuRev Server from 4.7.x, 4.8.x, or
4.9.x).

Upgrading an AccuRev Server from 4.7.x, 4.8.x, or 4.9.x

We strongly recommend that you perform a trial upgrade of your production data on a separate test
machine before using the procedure in this section to upgrade ‘in place’. This extra step will ensure that the
production server upgrade goes smoothly.

Plan to have enough disk space available to accommodate the increase in size required by the 6.x database.
(See the note under Performing an Upgrade Tn Place'on page 17 for more details.)

Note: If the test machine hardware is not up to the same specifications as your production server, the trial
upgrade procedures may take significantly longer to complete.

Performing a Trial Upgrade on a Test Machine
1. Make sure that you have performed the necessary steps from Before You Begin on page 8.

2. If you have not already done so (as specified in Running the AccuRev Installation Wizard on page 9),
perform an AccuRev back-up of the master or replica machine as described in the “Backing Up the
Repository” section of the AccuRev 4.x Administrator's Guide.

Move the files created during the full backup of AccuRev 4.x to your test machine.
4. On the test machine, log in as <ac-user> (UNIX/Linux) or a user with installation privileges
(Windows).

Important! Do not attempt to install the server as user root on UNIX/Linux. The installation will not
complete correctly.

5. Install AccuRev 4.7., 4.8.x, or 4.9.x on your test machine. See the AccuRev Installation and Release
Notes for that release for instructions.

6. Perform a full restore of the backed-up data on the test machine as described in the “Restoring the
Repository” section of the AccuRev 4.x Administrator’s Guide.
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10.

11.

12.

13.
14.

Start AccuRev on the test machine and ensure that is running correctly.

Stop the AccuRev Server process on the test machine according to the instructions in Starting and
Stopping AccuRev Servers on page 37.

Navigate to the <installer-/Ioc> directory and locate the downloaded AccuRev 6.2 installer.

Double-click the installer’s icon to launch it, or enter <instaf7-cma>on the command line. To run the
installer in console (i.e., text) mode, add a space and -i console to the end of the <install-cma>.

Proceed through the upgrade program.

Caution: The AccuRev 6.2 server does not start automatically after the AccuRev server upgrade. Do
not start the server until you have completed the database upgrade as described in the following step.

After the AccuRev Server installation is complete, tune your database (see Configuring Database
Tuning Parameters on page 30) and then go to Using the ‘maintain dbupgrade’ Command on page 32
and run the maintain dbupgrade command (first in “trial run” mode and then “for real”) to upgrade
your AccuRev 4.7.x database to AccuRev 6.2. Return here when done.

Ensure that the new accurev.lic license file exists in <ac-install>/storage/site_slice.

Start the AccuRev Server process according to the instructions in Starting and Stopping AccuRev
Servers on page 37. Test your installation and ensure that all data have been upgraded correctly.

Performing an Upgrade "In Place"

When you have successfully completed the trial upgrade on the test machine, perform the actual upgrade
procedure on your existing production installation. Make sure that you choose a sufficient window of
"quiet" time to perform the upgrade.

Notes:

The upgrade process will require additional disk space of up to twice the total used by the 4.x
metadata. (Note that metadata is only a fraction of your total AccuRev storage, as it does not include
your source files in the data directories.) The size of the upgraded 6.2 database may be as much as two
times that of the 4.x database.

Example: Consider an AccuRev 4.7.x installation with 800MB of metadata.

Disk space needed during the upgrade: up to 2.4 GB
Size of 5.x metadata: 1GB
Total metadata size after upgrade: 1.8 GB (1GB - 5.x metadata, 800MB — 4.7.x metadata)

Note: After a successful upgrade, you should back up your 4.x *_ndb files, then remove them
along with their corresponding *.ndx files from the <ac-storage>directory to free up disk space.

If you have previously installed the AccuRev Server on UNIX/Linux as user root, the upgrade will not
complete correctly. You will need to first (sudo) chown -R <ac-user> <ac-install>the old
directory.

When upgrading from 4.x to 6.2 all active sessions are lost. All users will have to re-login, including
those who have previously done a "login -n". Attention needs to be paid to the logins for triggers,
continuous integration, or build processes.

Rolling Back After Upgrading from 4.7.x, 4.8.x, or 4.9.x

Important: Rolling back a 6.2 upgrade from 4.7.x, 4.8.x, or 4.9.x will result in the loss of any changes that
occurred in the AccuRev repository between the time of the upgrade and time of the rollback.
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To roll back a non-trial upgrade and start a fresh upgrade from the original 4.7.x, 4.8.x, or 4.9.x metadata:
1. Make sure that all 4.x *_.ndb files are still present on the system.

2. Perform the following commands in order:

maintain rmsite <db-admin-name>
maintain dbupgrade <db-admin-name>

Upgrading an AccuRev Server from 5.0.x

When you upgrade from AccuRev Release 5.0.x to 6.2, the AccuRev Installation Wizard lets you preserve
your development data and configuration files, and installs the upgrade in the same place as your existing
version.

During the upgrade process, the Installation Wizard will prompt you for a folder that it can use to export/
import your current database and upgrade it for the updated version of PostgreSQL. Make sure that you
choose a location that has ample disk space to do this: the amount of space required is roughly equivalent
to your current AccuRev repository size. Although the default value of <ac-storage> may be fine for
small databases, you will probably want to change this for larger installations.

Important: When upgrading an existing 5.0.x installation, be sure to specify the same database
password (<db-admin-pass>) that is used by your existing database.

The upgrade process includes a PostgreSQL update. The data migration must be finalized by manually
running the maintain dbupgrade command (see Using the ‘maintain dbupgrade’ Command on page 32)
after the installer completes. The AccuRev Installation Wizard prompts you through these steps.

1. Make sure that you have performed the log in and back up steps described in Before You Begin on
page 8 and Running the AccuRev Installation Wizard on page 9.

2. Stop the AccuRev Server and PostgreSQL database processes as described in Starting and Stopping
AccuRev Servers on page 37.

3. See the Running the AccuRev Installation Wizard on page 9 to proceed through the remainder of the
Wizard.

The update process includes the following steps:
= Exporting your existing database from <ac-storage> to a temporary location.

= Updating PostgreSQL from Release 8.3 (used by AccuRev Release 5.0.x) to Release 8.4 (used by
AccuRev Releases 5.1 and higher).

= Importing your database from the temporary location back into <ac-storage>.

4. After the import has completed successfully, you will be prompted to run the maintain dbupgrade
command on your database to upgrade the schema. See Using the ‘maintain dbupgrade’ Command on
page 32.

5. Start the AccuRev Server and AccuRev DB Server processes as described in Starting and Stopping
AccuRev Servers on page 37.

Upgrading an AccuRev Server from 5.1 or Higher

To upgrade from AccuRev 5.1 or higher you must upgrade your database schema by manually running the
maintain dbupgrade command (see Using the ‘maintain dbupgrade’ Command on page 32) after the
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installer completes. Versions 5.1 and higher use the same version of the third-party database, so the
database upgrade is relatively quick. The AccuRev Installation Wizard prompts you through these steps.

Important: When upgrading an existing installation, be sure to specify the same database password
(<db-admin-pass>) that is used by your existing database.

1. Make sure that you have performed the log in and back up steps described in Before You Begin on
page 8 and Running the AccuRev Installation Wizard on page 9.

2. Stop the AccuRev Server and PostgreSQL database processes as described in Starting and Stopping
AccuRev Servers on page 37.

3. See Running the AccuRev Installation Wizard on page 9 to proceed through the remainder of the
Wizard.

The update process includes converting the metadata to UTF-8 for proper internationalization (118N)
support.

4. Start the AccuRev Server and AccuRev DB Server processes as described in Starting and Stopping
AccuRev Servers on page 37.

Upgrading a Replica Server
Use these instructions to upgrade an existing AccuRev replica server:

1. Perform a full backup and ensure that you have enough disk space as discussed above in Before You
Begin on page 8.

If your site uses AccuWork: For every replicated depot that has AccuWork issues, copy the entire
.../storage/depots/<depotName>/dispatch directory from the master server to each replica
server.Tip: Run "accurev show slices" to see the exact locations of your depots.

2. Proceed with the installation as if the replica server were a master server. Refer to the section
appropriate for your current installation:

= Upgrading an AccuRev Server from pre-4.7 on page 16

= Upgrading an AccuRev Server from 4.7.x, 4.8.x, or 4.9.x on page 16
= Upgrading an AccuRev Server from 5.0.x on page 18

= Upgrading an AccuRev Server from 5.1 or Higher on page 18

3. After the upgraded replica server has started, execute the following command against the replica
server:

accurev replica sync

Installing or Upgrading an AccuRev Client

This section describes the methods available to install and upgrade AccuRev Client software and
procedures for their use.
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Installation Methods
There are two methods for installing or upgrading the AccuRev Client:

= Aninteractive AccuRev Client-only installation requires the user to run an Installation Wizard and
provide information during the installation process. There are two possible ways to accomplish this:

= |f you download the Client-only installation package to the client machine and run the installation
executable manually, you can run the installation package with a graphical user interface (GUI) or
as a console (text-only) application. See Using the AccuRev Client-only Installation Package on
page 21 for more information.

= If you are upgrading an AccuRev version 5.5 (or later) client, and someone (typically, the system
administrator) has already downloaded the installation package to the AccuRev server, copied it to
the appropriate location, and renamed it as described in Enabling the Client Upgrade feature on
page 21, then you can automatically start the installation by selecting the Help -> Upgrade Client
option in the AccuRev GUI or by using the accurev upgrade_client in the CLI.

= Adfilent’AccuRev Client installation is typically used by the AccuRev administrator to automate the
client installation or upgrade process in a distributed or networked environment. "Silent™ installations
are run from the command line and do not require any interaction by the end-user. See Using Silent"
Client Installations on page 23 for more information.

Tip: Ask your AccuRev administrator if the "silent™ client installation method has been implemented at
your site.

Before You Begin

Regardless of which installation method you use, review the following steps before installing or upgrading
the AccuRev Client:

1. Read the Platform Support Notes on page 39 for your operating system before proceeding, and follow
the instructions there.

2. Check the Known Issues in AccuRev on page 66 for any issues that might apply to your site.

3. (Mac OS X users only) If you are installing the AccuRev Client on Mac OS X 10.7.5 or later, make
sure the Gatekeeper feature is set to allow applications to be downloaded from Anywhere. To access
this setting from the Apple menu, go to System Preferences... > Security & Privacy > General tab.

Tip: The AccuRev Client displays a notification message if it requires upgrading. This can happen when
the AccuRev Server has been upgraded but the AccuRev Client has not. The notification message gives the
user the option of downloading the AccuRev Client-only installation package directly from the AccuRev
Server.

Uninstalling Existing AccuRev Clients

If you are upgrading an AccuRev client, you do not need to uninstall any existing software. The AccuRev
Installation Wizard lets you preserve your development data and configuration files, and installs the
upgrade in the same place as your existing version.

Using Native Shells
AccuRev recommends using only shells that are native to/installed with the OS.
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Using the AccuRev Client-only Installation Package

The AccuRev Client-only installation package lets you install a new AccuRev Client or upgrade an
existing installation.

Downloading the Client-only Installation Package
If you have not already done so, take the following steps to download AccuRev client-only installation

packages:

1. Navigate to Product Updates on the Micro Focus Support Line page:
http://supportline.microfocus.com/

2. Select a search mechanism, then click Find Updates.

3. Check the license agreement, and then expand the Product and Version tabs to locate the appropriate
AccuRev release.

4. Locate the client-only installation packages you require and click the download button.

5. Depending on the installation package you have chosen, the downloaded file is either a .exe file or a

.bin file. Save this file to the appropriate location, which depends on your preferred method of
installation:

= Ifyou are a user planning to install AccuRev on your client machine manually, save the file to your
client machine.

= [fyou are an administrator who intends to make the file available to your users so that they can get
the file, copy it to their client machines, and run it manually, then save the file to some location and
inform your users where they can get the file to install it themselves.

= If you are an administrator and you want to enable the Client Upgrade feature for users who have
an existing installation of AccuRev 5.5 or later, then save the file to the appropriate location on the
AccuRev server and rename the file as described in the following section, Enabling the Client
Upgrade feature.

Enabling the Client Upgrade feature
If you are an administrator and you want to enable the Client Upgrade feature, take the following steps:

1.
2.

Download the client as described in Downloading the Client-only Installation Package.

When prompted, rename the file you just downloaded as AccuRevClientlnstall.[exe | bin], and copy
it to the appropriate location on your AccuRev server. For example, if you downloaded
accurev-6.2.1a-windows-clientonly.exe, save it to

c:\Program Files (x86)\AccuRev\bin\installers\Windows\AccuRevClientInstall.exe.

Important! Client-only install packages must be named AccuRevClientInstall.exe or
AccuRevClientInstall.bin or they will not be recognized by the client upgrade feature.

The client-only installation package is now available for AccuRev users, who can automatically
upgrade their AccuRev client by selecting Help > Upgrade Client in the GUI or by using the accurev
upgrade_client inthe CLI.
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Running the Client-only Installation Package
To run the AccuRev Client-only installation package, take the following steps:
1. Start the installation:
= If you are running the installation manually on your client, proceed to step 2.

= |f the Client Upgrade feature has been enabled as described in the previous section, Enabling the
Client Upgrade feature, start the installation by selecting Help > Upgrade Client in the GUI or by
using the accurev upgrade_client inthe CLI.

2. If you are manually installing AccuRev on your client machine, start the AccuRev Client Installation
Wizard using the applicable procedure:

Table 9. Starting the AccuRev Client Installation Wizard

Platform Installation Mode Run This Procedure

Windows GUI accurev-n.n.n-windowsclientonly.exe
where -n.n.n is the AccuRev version number
accurev-6.2.0-windowsclientonly.exe, for example

Console (text-based) accurev-n.n.n-windowsclientonly.exe -i console
where -n.n.n is the AccuRev version number
accurev-6.2.0-windowsclientonly.exe -i console, for example

UNIX/Linux GUI sh accurev-n.n.n-platform.bin

where:

® -n.n.n is the AccuRev version number

= platform is the UNIX/Linux platform name

sh accurev-6.2.0-linuxclientonly-x86.bin, for example

Console (text-based) sh accurev-n.n.n-platform.bin - i console
where:

® -n.n.n is the AccuRev version number

= platform is the UNIX/Linux platform name
sh accurev-6.2.0-linuxclientonly-x86.bin

- i console, for example

Tip: If you are installing the AccuRev Client from the console you can type:
= "back" to return to the previous prompt in the installation program
= "quit" to exit the installation program

3. Shutdown Existing AccuRev Apps -- When you start the AccuRev Client Installation Wizard, it first
reminds you to shut down any existing AccuRev applications. Click Next to continue. [Console: Press
Enter to continue.]

4. License Agreement -- Before you can proceed, you must click "I accept the terms of the license
agreement."” and then click Next to continue. [Console: You can type §'to agree, h'to refuse, or
press Enter to page through the license agreement.]

5. Choose Install Folder -- Specify a different directory if you do not want to use the <ac-install>
defaults: <homeDirectory>/accurev on Linux/UNIX, C:\Program Files (x86)\AccuRev 0N
64-bit Windows, C:\Program Files\AccuRev on 32-bit Windows. (See Determine Configurable
Elements on page 6 if you are not familiar with the values represented by <ac-instafi> and
<homeDirectory>.)
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10.

= |fyou are installing software for the first time and do not wish to use the default location, specify a
location where you have write permission.

IMPORTANT: If you are installing the AccuRev Client on a machine running Windows Vista,
you must install AccuRev in the \Users folder. If you install to the default Windows directory
(c:\Program Files\, for example), you not be able to use the Upgrade Client feature to upgrade
your AccuRev Client in the future.

= |If you are upgrading and the existing installation is not at the default location, specify your
existing AccuRev installation directory.

Click Next to accept the default and continue. [Console: Press Enter to accept the default and
continue.]

Configure: Set Host and Port [Console: Choose What Server to Connect To] -- Specify the values for
the Host and Port fields for the AccuRev Server to which this client will connect. You should accept
the default value for the server port chosen by the Installation Wizard unless you have a good reason to
change it. Click Next to continue. [Console: Prompts for these values individually. Type a value for the
host name and press Enter to continue. Review the value for the port number and press Enter again to
continue.]

Adjust System PATH Variable -- Responding Yes enables the AccuRev Client Installation Wizard to
modify the PATH environment variable on your system so that you do not need to specify a full path on
the command line when using AccuRev commands. Click Next to continue. [Console: Enter §"and
press Enter to continue.]

Note: You might need to reboot after installation before changes to the PATH environment variable
take effect.

Pre-Installation Summary -- At this point, the Installation Wizard displays a summary of the choices
you have made regarding your installation. Click Install to continue; otherwise click Previous to
change a value. [Console: Press Enter to continue; otherwise, type Back'and the press Enter to
return to change a value.]

Installing AccuRev -- The Installation Wizard displays a splash screen [Console: displays
Installing..."and a progress bar] while it installs the software on your local machine. It displays a
Please Wait message while it performs configuration tasks.

Installation Complete -- The Installation Wizard displays a message when the installation is
complete. Click Next to exit the program. [Console: Press Enter to exit the program.]

Note: If you are using the GUI installation wizard, when the installation is complete you are given the
opportunity to start the AccuRev user interface. To start the AccuRev user interface, accept the default
value of Yes and click Done. Otherwise, select No and click Done.

Using "Silent" Client Installations

So-called "silent” client installations allow the AccuRev Client software to be installed or upgraded in an
automated fashion, without requiring any interaction or input by the user on whose machine the AccuRev
Client is being installed. "Silent" client installations are particularly useful when AccuRev Client
installations or upgrades can be performed by a centralized software distribution mechanism. "Silent"
client installations provide a highly efficient mechanism for large AccuRev deployments to keep pace with
current versions of AccuRev.

Note: The "silent" upgrade is not supported for Mac OS X clients.
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Overview

In a "silent"” client installation, the Client-only installation package is pushed to each client machine. Then,
an AccuRev Client is installed manually on a single machine using a command line option to create a
response file. The response file records choices made during installation of the AccuRev Client, including:

= Installation directory
= The host (or IP address) and port number associated with the AccuRev Server

= Whether or not "<ac_install>/bin" should be added to the user’s path. See Determine Configurable
Elements on page 6 if you are not familiar with the value represented by
<ac-install>.

The response file resulting from the manual installation can then be used as input by the "silent" client
installer to automate the installation process on your system’s clients. Note that if you have clients on
multiple platforms (Windows and Linux, for example), you must perform one manual client installation on
each of them to create platform-specific response files.

Sample Response File. An example response file for a Windows installation is shown here:
# Wed Aug 01 17:50:06 EDT 2012
# Replay feature output

# This file was built by the Replay feature of InstallAnywhere.

# It contains variables that were set by Panels, Consoles or Custom Code.
#Choose Install Folder

USER_INSTALL_DIR=C:\\Program Files\\myAccuRev

#Configure: Set Host and Port

HOST_NAME_INPUT=localhost
HOST_PORT_INPUT=5050

#Adjust System PATH Variable

ADD_TO_PATH_INPUT_RESULTS=\"Yes\",\"\"
ADD_TO_PATH_INPUT_RESULTS_1=Yes
ADD_TO_PATH_INPUT_RESULTS_2=
ADD_TO_PATH_INPUT_RESULTS_BOOLEAN_1=1
ADD_TO_PATH_INPUT_RESULTS_BOOLEAN_2=0

#Install

-FileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\UninstallerData\\Uninstall\
AccuRev. lax=Yes
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leOverwrite C\:\\Program\

fi
i les\\myAccuRev\\bin\\Uninstal lerData\\resource\\iawin32.dlI=Yes

=
-FileOverwrite_C\:\\Program\ )
Files\\myAccuRev\\bin\\Uninstal lerData\\resource\\win64_32_ x64._exe=Yes

-FileOverwrite_C\:\\Program\
Files\\myAccuRev\\bin\\Uninstal lerData\\resource\\remove.exe=Yes

-FileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\vcredist x86_2010.exe=Yes
-FileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\vcredist x64 2010.exe=Yes
-FileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\acgui.lax=Yes
-FileOverwrite C\:\\Program\ Files\\myAccuRev\\bin\\acdiffgui.lax=Yes
-FileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\acclient.cnf=Yes
-FileOverwrite_C\:\\Program\ Files\\myAccuRev\\LICENSE.TXT=Yes

#Start AccuRev User Interface

START _UI_INPUT_RESULTS=\"\"",\"'No\"
START _UI_INPUT_RESULTS_1=

START _UI_INPUT_RESULTS_2=No
START _UI_INPUT_RESULTS_BOOLEAN_1=0
START _UI_INPUT_RESULTS_BOOLEAN 2=1

Creating the Response File

To create the response file, run the AccuRev Client-only installer from the command line. Use the

-r <filename> option to specify the full path of the response file. Note that if you have clients on multiple
platforms (Windows and Linux, for example), you must run the client installation procedure on one
machine on each platform in order to create platform-specific response files.

Windows example
<installer_Jocx\accurev-6.0._0-windowsclientonly.exe —r c:\tmp\ac_win_install.out
UNIX/Linux example

<installer_Jloc>/accurev-6.0_0-1inuxclientonly-x86.bin
—r /tmp/ac_linux_install_out
Running a "Silent" Installation

Once you have created the response file for a given platform, you can use it to perform automated "silent"
installations on other clients for that platform. To run a "silent” installation, invoke the AccuRev Client-
only installation package from the command line. Use the -i silent option to specify the installation type,
and the -f <filename> option to specify the full path of the response file to use as input.

Windows example

<installer_Jlocx>\accurev-6._0.0-windowsclientonly.exe -i silent
—F c:\tmp\ac_win_install._.out

UNIX/Linux example

<installer_Joc>/accurev-6.0.0-1inuxclientonly-x86_bin -i silent
—F /tmp/ac_linux_install_out
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Installing or Updating the AccuRev Web Ul Server

This section provides background information and procedures for installing or upgrading the AccuRev
Web Ul Server as a standalone installation using the AccuRev Installation Wizard.

This section is intended for the AccuRev administrator. If you are an end user and want to use the Web Ul
client, you simply need to open a supported Web browser and point it to an existing Web Ul Server using
URL information provided to you by your administrator.

Note: If you have already installed AccuRev as described in Step 5 of Running the AccuRev Installation
Wizard on page 9, the AccuRev Web Ul Server is already installed. Go to What to Do Next on page 28.

Before You Begin

Before running the AccuRev Installation Wizard, log in to the machine on which you will be installing the
AccuRev Web Ul Server. Log in as <ac-user> (UNIX/Linux) or a user with installation privileges
(Windows). (See Before You Begin on page 8 to learn about creating <ac-user>on UNIX/Linux
machines.)

Notes for UNIX/Linux Installations
= For security reasons, you CANNOT install the AccuRev server on UNIX/Linux if you are logged in as
root.

= See Known Issues in the AccuRev Installation and Release Notes.

How to Run the AccuRev Installation Wizard

This section describes how to install the AccuRev Web Ul Server using the AccuRev Installation Wizard.
If you are running the Installation Wizard in console mode, instructions are displayed in italicized brackets,
[Like this.]

To run the AccuRev Installation Wizard:

1. Start the Installation Wizard -- Start the AccuRev Installation Wizard you downloaded from the
Micro Focus SupportLine web site by double-clicking the installer icon, or by entering the installer
name on the command line as summarized in the following table. Note that the installation program
can be run with a graphical user interface (GUI) or as a console (text-only) application.:

Table 10. Starting the AccuRev Installation Wizard

Platform Installation Mode Run This Procedure

Windows GUI accurev-n.n.n-windows.exe
where -n.n.n is the AccuRev version number
accurev-6.2.0-windows.exe, for example

Console (text-based) accurev-n.n.n-windows.exe -i console
where -n.n.n is the AccuRev version number
accurev-6.2.0-windows.exe -i console, for example

UNIX/Linux GUI sh accurev-n.n.n-platform.bin

where:

= -n.n.n is the AccuRev version number

= platform is the UNIX/Linux platform name
sh accurev-6.2.0-linux-x86, for example
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Table 10. Starting the AccuRev Installation Wizard

Platform Installation Mode Run This Procedure

Console (text-based) sh accurev-n.n.n-platform.bin - i console
where:

® -n.n.n is the AccuRev version number

= platform is the UNIX/Linux platform name
sh accurev-6.2.0-Linux_x86 - i console, for example

Tip: If you are installing AccuRev from the console you can type:
= "back" to return to the previous prompt in the installation program
= "quit" to exit the installation program

2. License Agreement -- Before you can proceed, you must click “I accept the terms of the license
agreement.” and then click Next to continue. [Console: You can type {'to agree, h'to refuse, or
press Enter to page through the license agreement.]

3. Choose Install Folder -- Specify a different directory if you do not want to use the <ac-install>
defaults: <homeDirectory>/accurev on Linux/UNIX, C:\Program Files\AccuRev on Windows.
(See Determine Configurable Elements on page 6 if you are not familiar with the values represented by
<ac-install> and <homeDirectory>.)

= Ifyou are installing software for the first time, and do not wish to use the default location, specify
a location where you have write permission.

= If you are upgrading and the existing installation is not at the default location, specify your
existing AccuRev installation directory.

Click Next to accept the default and continue. [Console: Press Enter to accept the default and
continue.]

4. Choose Installation Type -- Select Web Ul Server only and then click Next to continue. [Console:
Type 2'and press Enter to continue.]

5. Configure: Set Host and Port -- In the Host and Port fields, set values for the AccuRev Server that
the Web Ul will use and click Next to continue. [Console: Prompts for these values individually. Type
a value and press Enter to continue.]

6. Adjust System PATH Variable -- Responding Yes enables the AccuRev Installation Wizard to
modify the PATH environment variable on your system so that you do not need to specify a full path on
the command line when using AccuRev commands. Click Install to continue. [Console: Type §"and
press Enter to continue.]

Note: You may need to reboot after installation before changes to the PATH environment variable take
effect.

7. 64-bit Hardware Detected -- If the AccuRev Installation Wizard determines that you are installing on
64-bit x86 hardware running a 64-bit Linux or Windows operating system, it offers you the option of
installing either a 32- or 64-bit version of the AccuRev Client. In all other situations, it installs the 32-
bit version by default. (IMPORTANT: See Table 5 on page 8 for limitations.) Optionally change the
value and click Next to continue. [Console: type ““1” for 32-bit or 2'for 64-bit and press Enter to
continue.]

Note: On 64-bit Linux and Windows, the AccuRev installer ALWAYS installs a 32-bit Java
runtime environment (JRE) for use by AccuRev. This means that even if you choose to install 64-
bit AccuRev on Linux, the Linux 32-bit compatibility libraries must always be installed. If this is

AccuRev® Installation and Release Notes 27



not the case, the AccuRev installation will fail. See Platform Support Notes, Linux on page 39 for
more information.

8. Installing AccuRev -- The Installation Wizard displays a splash screen [Console: displays Tnstalling”
with a progress bar] while it installs the software on your local machine. It displays a Please Wait
message while it performs configuration tasks.

9. Configure: Start AccuRev WebUI Server -- In a new installation, the Installation Wizard prompts
you to start the AccuRev Web Ul Server. Accept the default value (Yes) unless you want to start it
later. Click Next to continue. [Console: Press Enter to continue.]

10. Install Complete -- The Installation Wizard displays a message when the installation is complete.
Click Done to exit. [Console: Press Enter to exit.]

What to Do Next

The following table summarizes tasks you should consider performing after installing the AccuRev Web
Ul Server. See also Considerations for Users Upgrading from AccuRev 6.0 and Earlier.

Table 11. After Installing the AccuRev Web Ul Server

Task Comments

Start the Web Ul Server. You need to start the Web Ul Server to make the AccuRev Web Ul available to your users.

If you did not start the AccuRev Web Ul Server during the installation process, see
Starting, Stopping, and Testing the AccuRev Web Ul Server on page 29.

Test the Web Ul Before informing your users that the AccuRev Web Ul is available, perform a simple test
to make sure that it is working as you expect.

See Testing the AccuRev Web Ul on page 29.

Configure the Web Ul Server to | AccuRev has plug-ins for numerous IDEs like Eclipse and Visual Studio. To be able to
make it accessible by IDE plug- | access the AccuRev Web Ul in these IDES, you need to create a configuration file on the
ins for AccuRev. AccuRev Web Ul Server.

See Configuring the AccuRev Web Ul on page 29.

Review advanced configuration | You can use a configuration file to change the default session timeout, provide access to
settings. multiple AccuRev Servers, and more. These and other advance topics are described in the
AccuRev Web Interface Administrator’s Guide.

See Web Ul Release Notes on page 30.

Considerations for Users Upgrading from AccuRev 6.0 and Earlier

AccuRev versions 6.1 and later install a new version of the Tomcat web server, Tomcat 7; versions of
AccuRev prior to 6.1 used Tomcat 6. Tomcat is used by the AccuRev Web UI.
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Depending on your upgrade path and whether or not you customized your existing Tomcat web server, you
might have to perform additional steps in order for your Tomcat web server to operate as it did before
upgrading to AccuRev 6.2.1, as summarized in the following table:

Table 12. Customizing Tomcat after Upgrading to AccuRev 6.2.1

Current Did You
AccuRev Customize Are Additional Steps Required?
\ersion Tomcat?
6.1 or later No No.
Yes No.
6.0 or earlier No No.
Yes Yes. If you made any changes to your Tomcat 6 web server, you need to merge

those changes with your Tomcat 7 installation. For example, if you modified
server.xml, you need to reflect those modifications in the server.xml file that
is installed with Tomcat 7 -- the format of the Tomcat 6 server.xml file is
incompatible with Tomcat 7.

To help you with this process, AccuRev renames your
<AccuRev_install>\WebU I\tomcat directory to
<AccuRev_install>\WebUI\tomcat.old when you upgrade.

Starting, Stopping, and Testing the AccuRev Web Ul Server

Linux shell (.sh) and Windows batch (.bat) scripts are provided for stopping and starting the Tomcat web
server for the AccuRev Web Ul:

<ac-install>/\ebUl/tomcat/bin/[ startup | shutdown ].[ sh | bat ]

Testing the AccuRev Web Ul
To test the AccuRev Web U, open a browser and enter the following URL.:

http://<webui-host>:8080/accurev

If this does not display an AccuRev login window, try restarting the AccuRev Web Ul Tomcat server. See
Starting, Stopping, and Testing the AccuRev Web Ul Server on page 29. If the Web Ul appears as expected, you
can make this URL available to users to whom you want to provide access to the AccuRev Web UI.

Also, if you want to make the Web Ul accessible through your users’ AccuRev GUI, you should ensure
that the AccuRev installation is included in their PATH setting. If they try to open the Web Ul from the
AccuRev GUI (using the View > Open in Web choice on the AccuRev GUI menu, for example) and the
Web Ul login screen appears but does not display a valid server to connect to, the PATH is probably not set
correctly.

Configuring the AccuRev Web Ul

This section describes how to configure the AccuRev Web Ul to make it available to:
= The AccuRev GUI (some features in the AccuRev GUI make use of the Web Ul)
= AccuRev IDE integrations (like the Eclipse plug-in for AccuRev, for example)

You do this by creating a settings.xml file on the AccuRev Server as described in the following procedure.
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Creating the settings.xml file

Instructions for creating this file are found in the AccuRev Installation and Release Notes for each
integration, but in summary:

1.
2.

Shut down any third-party packages.

Create a file called settings.xml in the <ac-install>/storage/site_slice/dispatch/config
directory.

Edit the file to add the lines shown below (replacing <webui-host>with the actual name of the host
providing access to the AccuRev Web Ul), and save it.

<settings>

<webui url="https://<webui-host>:8080/accurev"'/>
</settings>
(If necessary, change the port from “8080 to the value in use at your site.)

Note: Refer to the installation and release notes for specific AccuRev integrations (Eclipse and Visual
Studio plug-ins, for example) for additional information specific to your third-party IDE.

Restart any third-party packages shut down in Step 1.

Web Ul Release Notes

Release notes for the AccuRev Web Ul are in Changes in AccuRev Web Ul Release 6.1 on page 78. See the
AccuRev Web Interface Administrator’s Guide for post-installation configuration information.

Configuring Database Tuning Parameters

Use these instructions to set the database tuning parameters to allow the database to make the best use of
your system resources. You should do this after installing AccuRev but before starting the server or before
running the maintain dbupgrade command.

1. Loginas <ac-user>.
2. Ensure that the database server is stopped using the procedures described in Starting and Stopping

AccuRev Servers on page 37.

3. To improve database performance you may elect to increase the amount of memory allocated
exclusively to PostgreSQL by editing <ac-storage>/db/postgresql.conf.

»= (non-Windows platforms) Note that editing postgresql.conf could also require you to alter part of
your operating system's kernel configuration and possibly reboot your system. Read the section
applicable to your operating system at http://www.postgresql.org/docs/8.4/static/kernel-
resources.html for more information.

» shared_buffers — Change to 512MB or 25% of total physical memory installed on the machine
running AccuRev, whichever is less.

» effective_cache_size — Set to 75% of free physical memory reported by the operating system
when both AccuRev and the database are stopped (see Starting and Stopping AccuRev Servers on
page 37).

Free physical memory can be estimated as follows:
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= UNIX/Linux (expressed in MB):

free -m | awk "/buffers.cache/{print $4}"

=  Windows Server 2008/Windows 7 or later (expressed in MB): Access the Performance tab on
the Windows Task Manager. Use only the Available value under “Physical Memory”.

Phrysical Memory (ME)

Tokal G151
Cached 3731
Svailable 38T
Free 139

= Other operating systems: You may be able to use the top command; refer to your operating
system vendor’s documentation.

Note: On 64-bit operating systems with more than 4GB of memory, the effective_cache_size
is not limited to 4GB, as it does not reflect memory allocated by PostgreSQL. This setting is an
estimate of the amount of memory available to the operating system for filesystem caching.

4. Start the AccuRev Database Server process according to the instructions in Starting and Stopping
AccuRev Servers on page 37.
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Using the ‘maintain dbupgrade’ Command

This section details the use of the maintain dbupgrade command to upgrade your existing AccuRev
database to 6.2.

For 4.x databases (4.7 or higher), dbupgrade performs these tasks:

= Performs validation and cleanup of 4.x metadata records.

= Converts the metadata to UTF-8 for proper internationalization support.

= Imports the metadata to the third-party database used with AccuRev 5.x.

For 5.0.1 and 5.1.x databases, dbupgrade upgrades the AccuRev database schema. (5.0.5 and 5.2
databases are already internationalized, so they do not require UTF-8 conversion.)

IMPORTANT: Before performing the dbupgrade operation, ensure that you have tuned your database as
described in Configuring Database Tuning Parameters on page 30, and have restarted your database so
that the tuning parameters take effect. Also ensure that you have left yourself an adequate window of time:
each dbupgrade run can take several hours, particularly if you are performing trial runs and upgrades on a
test machine that is not particularly fast.

You will be prompted to perform the dbupgrade process in two steps:
1. In"trial run" mode, to evaluate how the upgrade process will succeed.
2. In"force" mode, where your database will actually be converted.

See the "The “‘maintain’ Utility" chapter of the AccuRev 6.2 Administrator’s Guide for more details about
this utility.

Performing a "Trial Run" Upgrade

To begin the upgrade process, change to the <ac-instaf1> /bin directory and enter the following at the
command line:

maintain dbupgrade <db-admin-name>
You will be prompted for <ab-admin-pass>, and then asked whether you want to run the upgrade as a
“trial run”, using a default codepage of “CP1252” (a superset of 1ISO-8859-1). Performing the conversion
as a trial run means that your database will not be changed, but you will be notified of any issues so you
can determine whether or not to repeat the upgrade in non-trial mode (and actually convert your database).

The codepage specification allows dbupgrade to attempt a reasonable conversion of your existing data to
UTF-8. The default CP1252 codepage (“Western European”), although considered as “Windows”
codepage, is a superset of ISO-8859-1 and is a reasonable starting point for both Windows and Linux
servers, especially in mixed environments. Only specify a different codepage if you know for certain that
you use a different one at your site.

When prompted whether or not you wish to proceed with a trial run, answer Y to perform the trial upgrade.
(N performs a real upgrade that will modify your data.)

The upgrade process can take several hours, depending on factors such as your hardware, the size of your
database, system load, etc. All information is captured in the following log files:

"  <ac-storage>/site_slice/logs/dbupgrade.log

"  <ac-storage>/site_slice/logs/dbupgrade_i18n_report.html
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If you make multiple dbupgrade runs, any existing log files are backed up with time-stamp names. It is
critical that you get a successful trial run, and review the logs for any problems prior to performing an
actual database upgrade. If you have any questions about the results, you should contact AccuRev Support
Services (http://accurev.force.com/customerportal).

See Understanding maintain dbupgrade Messages on page 33 for descriptions of messages that appear
during the upgrade.

Understanding maintain dbupgrade Messages
During the data migration, several AccuRev tables will be altered, resulting in some or all of the messages
described in this section.

Messages from maintain dbupgrade
When the upgrade completes successfully, a message like the following appears at the end of the output:

AccuRev 4.x to 5.x metadata migration completed without errors in 0.11
minutes.

*** The AccuRev database has been upgraded.

The AccuRev Server is ready to be started.

If errors are detected during the migration, a message similar to the one shown below will appear at the end
of the output:

AccuRev 4._.x to 5.x metadata migration completed with errors in 0.11 minutes.

*** Errors were detected during the 4.x to 5.x metadata migration
processing.

See /opt/accurev/storage/site_slice/logs/dbupgrade.log for details.
The AccuRev Server WILL NOT start until the upgrade is successful.

Please contact AccuRev Service for assistance.

Additional details are available in the file <ac-storage>/site_slice/logs/dbupgrade. log.

See the following section, Messages from the dbupgrade.log File, for details on locating and interpreting
the reasons for any failures.

Messages from the dbupgrade.log File

Note: Please store the <ac-storage>/site_slice/logs/dbupgrade.log file in a safe place. It contains
information that could assist AccuRev Support Services with troubleshooting any data migration or
database upgrade issues.

The dbupgrade. log file consists of log entries of the following severity levels, in ascending order:
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INFO -- Status messages indicating what the dbupgrade utility is doing at a particular point in
time. The intended audience for this category of messages is primarily AccuRev Support Services.

= NOTICE -- Messages that record information about the dbupgrade operation that might be of
interest to the user. Example: Translations of non-ASCI1 characters from CP1252 to UTF-

8 will be reported in C:/Program Files/AccuRev/storage/site_slice/logs/
dbupgrade_i18n_report.html

=  WARNING -- These messages indicate that maintain dbupgrade encountered an issue that may
require your attention but does not necessarily constitute a reason to fail the data migration/
upgrade. You must evaluate any WARNING messages and determine if you can proceed with the
results of the dbupgrade operation. See the examples and additional information in Warning
Messages on page 34.

= FATAL -- These messages indicate that maintain dbupgrade encountered a serious problem that
prevented it from completing. You must address any FATAL issue (usually with the help of
AccuRev Support Services) and rerun dbupgrade before proceeding.

As an end-user, you should only be concerned with WARNING and FATAL entries.

Warning Messages
Warning message example #1:

0 Unable to find storage location for depot: depot _name: /path-to-storage/depots/
depot_name

-Error- 1 - prj.c:211 - Unable to initialize depot - System Error: 2 No such file or
directory

WARNING: Depot “"depot_name® skipped: Unable to initialize: No such file or
directory: 0S error: see above

Explanation:

Ensure that the depot is supposed to still be active, and that the data for the depot is actually present on the
system. You may need to use either the chslice or rmdepot AccuRev commands to remedy the problem.
This condition is most likely to occur during a trial run on a test machine (as opposed to "in-place" -- see
Performing a Trial Upgrade on a Test Machine on page 16.)

Warning message example #2:

WARNING: Would migrate site... FAILED

WARNING: Would migrate depot "depot name® ... FAILED
WARNING: Migrating site... FAILE

WARNING: Migrating depot_<depot_name" ... FAILED
WARNING: Would upgrade site... FAILED

WARNING: Would upgrade depot 'abgot_name'... FAILED
WARNING: Upgrading site... FAILE

WARNING: Upgrading depot *"depot name® ... FAILED

Explanation:
One or more errors have occurred which prevented the site slice/depot in question from being migrated or

upgraded. One or more corresponding log entries with severity FATAL should be present in
dbupgrade . 1og prior to this WARNING entry, with the specific reasons for the errors.
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Warning message example #3:

WARNING: AccuRev 4.x to 5.x metadata migration trial run completed without errors in
X minutes. *** The AccuRev Server WILL NOT start after the migration trial run.

Explanation:

You have successfully completed a trial migration from AccuRev 4.x to 5.x, but you must analyze the
results and re-run the migration “for real” in order for the AccuRev Server to start. You must now review
the dbupgrade_i18n_report.html file for correctness (see the "Messages from
dbupgrade_i18n_report.html on page 36"). Then, if all highlighted characters in
dbupgrade_i18n_report.html are correct, proceed to perform the actual migration as described in
Performing the Actual Database Upgrade on page 37. Test your installation. If you were doing the
upgrade on a test machine, return to Performing an Upgrade I'n Place'dbn page 17 to complete the
upgrade on your production machine.

Warning message example #4:

WARNING: Would change database encoding to UTF-8: cannot proceed any further without
making changes to the database, stopping _ _ )

WARNING: Would create a UTF-8 case-insensitive index: cannot proceed any further
without a UTF-8 database, stopping _ ) ) )
WARNING: AccuRev database upgrade trial run completed without errors in X minutes.
*** No changes were made to the database during the upgrade trial run.

Explanation:

You are performing a trial upgrade from 5.0.x/5.1 to 6.2, which adds internationalization (118N) support.
Everything up to the point where the database is switched to UTF-8 has completed successfully, but the
actual switch cannot occur during a "trial™ run. You must now review the dbupgrade_i18n_report._html
file for correctness (see Messages from dbupgrade_i18n_report.html on page 36). Then, if all highlighted
characters in dbupgrade_i18n_report.html are valid, proceed to perform the migration "for real" (see
Performing the Actual Database Upgrade on page 37, and Upgrading an AccuRev Server from 5.0.x on
page 18 or Upgrading an AccuRev Server from 5.1 or Higher on page 18.)

Fatal Messages
Fatal message example #1:

FATAL: AccuRev 4.x to 5.x metadata migration completed with errors in X minutes. ***
Errors were detected during the 4_.x to 5.x metadata migration processing. See /path-
to-/dbupgrade.log for details. The AccuRev_Server WILL NOT start until the upgrade
is successful. Please contact AccuRev Service for assistance.

FATAL: AccuRev database upgrade completed with errors in X minutes. *** Errors were

detected during the database upgrade proceSS|ng- See %s/%s for details. No changes

were made to the database. Please contact AccuRev Service for assistance.
Explanation:

One or more errors have occurred which prevented the migration or upgrade from completing. Additional
log entries with severity FATAL should be present in dbupgrade . log with the specific reasons for the
errors.

Fatal message example #2:
FATAL: File not found - /path-to-storage/depots/depot-name/table-name.ndb
Explanation:

You are migrating from 4.x to 6.2 and the 4.x ndb file in question cannot be found. If the file is part of a
depot that is no longer active, you may want to first rmdepot depot-name in 4., then retry the migration.
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Fatal message example #3:

FATAL: Depot contains AccuWork issues, but the corresponding schema.xml definition
could not be found or loaded

Explanation:

The AccuWork schema.xml file is missing from the
<ac-storage>/depots/depot-name/dispatch/config directory.
Fatal message example #4:
FATAL: Database error: ...
FATAL: Retrieving list of depots from database: Database error: ...
FATAL: table "X" rowcount mismatch: expected Y, got Z
FATAL: LOC width X not supported!
Explanation:

If you receive any of these errors, contact AccuRev Support Services (http://support.accurev.com).

Messages from dbupgrade_i18n_report.html

Note: Store the <ac-storage>/site_slice/logs/dbupgrade_i18n_report.html file in a safe place. It
contains information that could assist AccuRev Support Services with troubleshooting any data migration
or database upgrade issues.

The information in dbupgrade_i18n_report.htm contains the results of the UTF-8 conversion based on the
code page that you specified. Open this report in a web browser and look for any highlighted characters --
these represent non-ASCII characters found during the conversion.

Some highlighted characters can be ignored. For example, accents and umlauts may have been introduced
when adding a foreign document to the depot. Likewise, some highlighted characters may be simple non-
ASCII punctuation characters like em dashes (“—7). However, if a highlighted character does not look
valid, it probably needs to be corrected.

To research the origin of suspect entries, use the information in the report to find the characters in your
existing, running AccuRev installation (4.x, 5.0.x, or 5.1):

1. Click on the triangular handle next to any highlighted entry to see where it is being referenced (depot,
stream, etc.). For example, in the illustration below, clicking on the handle next to “Stream name”
reveals that two non-ASCII characters appear in the stream name that begins “LINE tests bld”.
Clicking on the handle for this entry narrows down the location to depot_id 13 and stream_id 2802.

¥ Stream name

¥ LINE tests bld 1.7y (RUN, 10-07-07)y

depot_id: 13, stream_id: 2802 time: 1178784798

2. Use the displayed information (depot_id, stream_id, issue_num, etc.) to navigate to the suspect entry
in your existing (4.9, 5.0.x, or 5.1) AccuRev Ul.
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3. Compare the appearance of the suspect entry in the report against how it appears in your existing
AccuReyv installation.

Here are some general rules for interpreting these results:

= All highlighted characters are correct. Your data will convert cleanly, and you can proceed to
perform the actual upgrade without a trial run:

maintain dbupgrade -f -E CP1252 <db-admin-name>
(Note: Use the exact same maintain dbupgrade command on the replica servers, if any.)

= Some highlighted characters are incorrect. Determine whether or not these characters are
acceptable, or if you can fix them after the upgrade. For example, you might be able to rename a
stream or a file. Note: Because of AccuRev’s TimeSafe® feature, snapshots and time-based streams
will preserve the pre-rename, incorrect information.) If in doubt about how to proceed, please contact
AccuRev Support Services (http://accurev.force.com/customerportal).

»= There are many incorrect highlighted characters and the problem seems to be consistent. If you
can identify a recurring, common problem, you probably need to use a different code page. For more
information about code pages, start with http://en.wikipedia.org/wiki/Character_encoding.

Performing the Actual Database Upgrade

Once you have fixed any issues reported by the "trial run" upgrade, you can perform the actual database
upgrade by re-running the maintain dbupgrade command as described in the previous section, but
responding N when prompted whether or not you wish to run in trial mode, and confirm your choice.

Starting and Stopping AccuRev Servers

This section describes the procedures you can use to start and stop the AccuRev Server and the AccuRev
Database Server.

Starting and Stopping the AccuRev Server

Use the procedures below to start and stop the AccuRev Server.

Starting
Platform Interface Start Procedure
Windows GUI Services window > Locate service, right-click, choose Start Service
Command line net start accurev
UNIX/Linux Command line cd <ac-install>/bin
./acserverctl start
Stopping
Platform Interface Stop Procedure
Windows GUI Services window > Locate service, right-click, choose Stop Service
Command line net stop accurev
UNIX/Linux Command line cd <ac-install>/bin
./acserverctl stop
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When you start the AccuRev Server, the database is automatically started first.

Starting and Stopping the AccuRev Database Server

Use the procedures below to start and stop the AccuRev Database Server.

Starting
Platform Interface Start Procedure
Windows GUI Services window > Locate service, right-click, choose Start Service
Command line net start "accurev db server"
UNIX/Linux Command line cd <ac-install>/bin
./acserverctl dbstart
Stopping
Platform Interface Stop Procedure
Windows GUI Services window > Locate service, right-click, choose Stop Service
Command line net stop "accurev db server"
UNIX/Linux Command line cd <ac-install>/bin
./acserverctl dbstop

When you stop the AccuRev Database, the AccuRev Server is automatically shut down first.

Summary of Start and Stop Operations
In summary:

= Starting the AccuRev Server will automatically start the AccuRev Database if it is not already
running.

= Stopping the AccuRev Server will NOT automatically stop the AccuRev Database.
= Starting the AccuRev Database will NOT automatically start the AccuRev Server.

= Stopping the AccuRev Database will also stop the AccuRev Server, but only if you say "Y" to the
prompt. Otherwise, neither will be stopped.

See "Controlling Server Operation” in the AccuRev 6.2 Administrator’s Guide for more information, and
for setting up your system to automatically start the AccuRev processes at boot time.

Enabling the Reprise License Manager (RLM)

Previous AccuRev releases installed both the now-deprecated named "keys.txt" license manager, as well as
the newer RLM, which supports 24-hour flexible licenses and 7-day standard licenses using the
accurev.lic license file.

The AccuRev 6.2 installation process should automatically configure your system correctly, assuming you
have a valid accurev.lic file, even if you installed the named "keys.txt" manager in a previous release. See
the "License Management" chapter of the AccuRev 6.2 Administrator’s Guide for more details.
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The procedures for starting the RLM server are summarized in the following table:

Platform Interface Procedure

Windows GUI Services window > Locate service, right-click, choose Start Service

Command line net start "accurev rim"

UNIX/Linux Command line rim -c <path to accurev.lic> -dlog <path to RLM log
file>

Platform Support Notes

The following sections contain important information about installing AccuRev software on specific
hardware/software platforms.

Platform Support Matrix

For the most up-to-date list of supported platforms, go to http://supportline.microfocus.com/
prodavail.aspx.

Important Notes:

1. The Platform Support Matrix lists the platforms that have been tested for the AccuRev 6.2 server and
client. We will investigate and attempt to address issues reported on other platforms, but we reserve the
right to request that you reproduce the problem on a supported platform.

2. We will investigate and attempt to address issues reported on virtualization platforms not supported by
AccuRev, but we reserve the right to request that you reproduce the problem on one of the supported
OS platforms listed in the Platform Support Matrix, running in a non-virtualization environment.

3. See Deprecated Features on page 103 for platforms that are no longer be supported.

Java Compatibility

AccuRev 6.2 is compatible with the Java 2 Runtime Environment (JRE), Versions 1.7.x and higher.

(UNIX/Linux only) Workaround for Java Runtime Library Problems

The AccuRev Installation Wizard and the AccuRev GUI fail on some UNIX/Linux platforms because of
Java library problems. Use this procedure to work around these problems:

1. Run the Installation Wizard with environment variable LIBXCB_ALLOW _SLOPPY_LOCK set to the
value 1.

2. Fix the runtime library file in the new AccuRev installation area:
> cd ac-install/jre/1ib/i1386/xawt
> sed -i "s/XINERAMA/FAKEEXTN/g®" ./libmawt.so
Linux

= PostgreSQL may fail to function properly when SELinux mode is set to “Enforcing”. See http://
docs.fedoraproject.org/en-US/Fedora/13/html/SELinux_FAQ/#id2963608 for more information. To
find out the current SELinux mode run getenforce (as root). To set SELinux mode to “Permissive”,
run setenforce PermissiveEdit.
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Linux systems require glibc version 2.4 or higher. To determine your glibc version, run
rpm -qi glibc in a command shell. Ubuntu systems require libc6-i386.

The AccuRev Installation program and the AccuRev GUI fail on some older UNIX/Linux platforms
because of Java library problems. Use this procedure to work around these problems:

= Set the environment variable LIBXCB_ALLOW_SLOPPY_LOCK to the value 1.
* Run the installation program.
= Fix the runtime library file in the new AccuRev installation area:

> cd <ac-install>/jre/lib/i386/xawt
> sed -1 "s/XINERAMA/FAKEEXTN/g® ./libmawt.so

(64-bit Linux) If the 32-bit versions of the libraries listed below are not present on your system,
download and install them (and their dependencies) prior to running the installer. You must have these
32-bit libraries installed even if you are installing the 64-bit version of AccuRev.

Note that newer versions of Red Hat, Fedora, SUSE, and Ubuntu no longer provide packages
containing comprehensive 32-bit compatibility libraries (for example, ia32-libs), but rather encourage
users to install only the libraries they need. If you are using an older version of these operating
systems, some of these libraries might already be present on your machine.

» ibc6:i386

= libice6:i386
= librenderl:i386
= libx11-6:i386
» libxau6:i386
»  libxaw7:i386
= libxext6:i386
» |ibxi6:i386

»  libxmu6:i386
» libxtst6:i386
= zlib1g:i386

Note: This list gives the name and notation (:i386, for example) required for Unbuntu 13.10.
Comparable libraries are present in other Linux distributions -- libxaw.i686 instead of libxaw7:i386,
for example.
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= (64-bit Linux) If you are installing a 32-bit version of AccuReyv, and if you are using NSS or PAM
authentication modules (e.g. for LDAP, NIS, etc.), you must ensure that the corresponding 32-bit
versions of those authentication modules are also installed.

For example:

> arch
Xx86_64

> rpm -gq --queryformat "%{n}-%{arch}\n™ nss_ldap

nss_ldap-x86_64

nss_ldap-i386

If you only have the x86_64 version of this library installed on your system, please update to a "biarch"
version of the package, or download and install the 32-bit version of the package (in addition to the 64-
bit version already installed on your system).

AlIX

= Only the AccuRev client software is supported on this platform.
= You cannot upgrade the AccuRev Client using the Help > Upgrade Client menu choice.

= If you use the console method to upgrade your AccuRev Client, the response file is not read; you must
provide values for host, port, and path when prompted.

= The following shared libraries must be accessible, both by the AccuRev Installation Wizard and by the
installed AccuRev executables. The pathnames below show typical locations for these shared libraries.

/usr/freeware/lib/libgry?to.a
/usr/freeware/lib/libintl.a
/usr/lib/libc.a
/usr/lib/libcrypt.a
/usr/lib/libdl.a
/usr/lib/libpthread.a
/usr/lib/libpthreads.a

Note: It is recommended that the LIBPATH environment variable not be set, as it can interfere with the
loading of libraries from /opt/accurev/bin.

The libraries above are typically part of the following AIX filesets and/or open-source RPM packages:

= bos.loc.utf.EN_US (or any other non-EN_US UTF locales)
= bos.rte.bind_cmds

* bos.rte.libc

= bos.rte.libpthreads

=  bos.rte.security

= openssl-0.9.7X

= gettext-0.17-1 (or later)

= AIX5.3: fix pack 5300-07 or newer required

= AIX6.1: fix pack 6100-GOLD or newer required

= AIX 7.1: fix pack 7100-GOLD or newer required
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The installer mistakenly warns you that you have not chosen the bundled JRE. Complete the
installation, then change this setting in /opt/accurev/bin/acgui.lax:

lax.nl._current.vm=._/jre/bin/java

SunOS / Solaris

The AccuRev Server and Client are supported on both Solaris Sparc and Solaris x86.

As of AccuRev 5.6, the AccuRev Server is available only as a 64-bit application; it cannot be installed
on 32-bit Solaris machines. The following table summarizes considerations for upgrading existing
AccuRev Server installations:

Table 13. Upgrading to AccuRev Server 5.6 on Solaris

Existing AccuRev Server

. Comments
\ersion
4.x AccuRev 4.x required you to install as root. In AccuRev 5.6, you cannot install as root. In
order to successfully upgrade to AccuRev 5.6, you must first run the following command
on your existing AccuRev installation:
(sudo) chown -R <ac-user> <ac-install>
5.x (5.5 and earlier) AccuRev 5.x (5.5 and earlier) used a 32-bit version of the PostgreSQL database which is

not compatible with the 64-bit version of the PostgreSQL database used by AccuRev 5.6.
If you are upgrading from AccuRev 5.x, contact AccuRev support for assistance migrating
your 32-bit PostgreSQL database:

= (o to http://accurev.force.com/customerportal

= Or write AccuRev technical support at support@accurev.com

If you upgrade the AccuRev Client using the console mode, you are not prompted to provide values for
host, port, and path. AccuRev uses values from your existing AccuRev Client installation to perform
the upgrade.

The following shared library must be accessible, both by the AccuRev Installation Wizard and by the
installed AccuRev executables. The pathname below shows the typical location for this shared library.

/usr/stw/lib/libgcc_s.so.1

Note: It is recommended that the LD_LIBRARY_PATH environment variable not be set, as it can
interfere with the loading of libraries from <ac-instalI>/bin.

The library above is typically part of the following SUN package:
= SUNWgccruntime

Restrictions on the Use of AccuRev Clients in Solaris Zones
The following restrictions apply to the use of AccuRev clients in Solaris zones:

The AccuRev Server should be run from a global zone. If you want to run an AccuRev Server from a
non-global zone, you should give that zone a private disk volume and not use a loopback mount to the
global zone for any of the AccuRev Server metadata or storage files.

Workspaces can only be created on zones with private host names.
Workspaces in the non-global zone cannot be used from the global zone.

Workspaces on NFS mounts (not recommended) must be NFS-mounted directly from the non-global
zone, not through a loopback mount in the non-global zone to an NFS mount in the global zone.
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Solaris requires operating system patches, as described on the Oracle Technology Network
(http://www-oracle-com/technetwork/systems/patches/index-html)

Windows

Disable anti-virus checking for the <ac-storage> directory and all directories beneath it to avoid
performance problems associated with anti-virus checks.

Machines running Windows 7 should be upgraded to SP1 if you will be using mounted workspaces.
For example, assume that you have the logical drive P: mapped to a path similar to \\raid\public,
and your workspace is in p:\myuser\myworkspace. If you try to issue an accurev info command in
that directory, you may see an exception from "aos.c" that displays the error message - "no mounted
filesystem matched path ... "

Mac OS X

AccuRev Release 6.2 supports only the AccuRev client software on the Mac OS X platform.

The following is a recommended method for getting all required executables into the PATH for Mac
OS X:

Create the following three files using "sudo":

sudo echo *"'/Applications/AccuRev/bin™ > /etc/paths.d/AccuRev

sudo echo ""/Applications/AccuRev/bin/acdiffgui.app/Contents/Mac0S™ >
/etc/paths.d/Acdiffgui

sudo echo ""/Applications/AccuRev/bin/acgui .app/Contents/Mac0S™" >
/etc/paths.d/Acgui

To enable the AccuRev diff GUI tool (acdiffgui) to work stand-alone as well as from an IDE
integration such as Eclipse, do the following:

1. Make a backup copy of acdiffgui:

cd /Applications/AccuRev/bin/acdiffgui .app/Contents/Mac0S

mv acdiffgui acdiffgui.orig

2. Create a new acdiffgui file with the following content:

#1/usr/bin/perl

my $acbin = "/Applications/AccuRev/bin”; L ) ) ) )

my @jars = gw(oro.jar xerceslmpl.jar xml-apis.jar fw.jar werken.opt.jar diff.jar);
my $cp = join(":", map {"$achin/$_"} @jars);

my _@args = ('1 va®, "-Duser.dir=$acbin™, "-Xms32M®, "-Xmx512M*, "-classpath®, $cp,
"diff.DiffApp -, QARGV);

system (@args);

3. Create the following link:

In -s /Applications/AccuRev/bin/acdiffgui .app/Contents/MacOS/acdiffgui
/Applications/AccuRev/bin/acdiffgui

4. Close any shells.
5. Open a new shell.

Running acdiffgui should now bring up the AccuRev graphical diff tool, and it should also work
from within any integrated IDE.
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Uninstalling AccuRev

On Windows, we recommend that you run <ac-instafI>\bin\UninstallerData\Uninstall
AccuRev . exe to ensure that the AccuRev services and registry entries are removed cleanly. Back up and

remove any folders and files left under <ac-install>.

On UNIX/Linux, simply halt and remove any AccuRev services, and back up and remove any folders and
files left under <ac-install>.
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AccuRev 6.2.2 Release Notes

This chapter describes changes and other information related to AccuRev Version 6.2.2 (AccuRev 6.2.2).

Note: To ensure optimal performance, install all applicable updates for your operating system.

Deprecated Features

The following features will not be supported in future releases:

= AccuRev Server on 32-bit environments. Future versions of AccuRev Server will require 64-bit
environments.

=  Windows Vista, and 2003 Server.

= AccuRev 6.2.2 supports Red Hat Enterprise 4 via the command line (CLI) only. The GUI is no longer
supported.

The following features are no longer supported in AccuRev 6.2.2:
= Windows XP is not longer supported.

= OS X 10.6 (Snow Leopard) and 10.7 (Lion) are no longer supported in 6.2.2 due to the Java 1.8
upgrade in release 6.2.1a.

= Vista now requires SP2 for 6.2.2. SP1 is no longer supported.

Changes in AccuRev Release 6.2.2

AccuRev Release 6.2.2 includes the following new features and bug fixes.

Note: In cases where an issue is identified with two numbers, such as 25296 (1095910), the first
represents the issue number in the AccuWork issue tracking system; the second, in parentheses, is the
issue number in the SupportLine system used by Customer Care.

Added Support
AccuRev 6.2.2 now supports the following platforms:
-Windows 10
-Red Hat Enterprise 7
-OS X 10.10 (Yosemite) and 10.11 (El Capitan)

27702 (1098155) -- Merge of UNIX EOL ptext file on Windows results in file to have
Windows EOL

The GUI now supports and includes Borland's StarTeam diff/merge tool as a workaround.
29929 (609833) -- Problems with circular xlinks in the name command

The server would crash when the name command encountered a circular xlink. This has been resolved.
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31599 (609972) -- Updated ACL name being changed via setacl to pass to the
server_admin_trig.pl

Per request, added new inputs to the server_admin_trig when using setacl: objectType, object, idName,
rights.

32038 (1099792) -- Cannot use 'now' in stream diff -t arg
In this release, diff -t accepts 'now’.
35525 (1096314) -- Provide ability to set max size of files within AccuRev

With this release, the element size is now passed to the preop trigger for add and keep, allowing an
administrator to enforce a maximum file size in AccuRev. Please refer to the example
server_preop_trig.pl to see how to limit files by size in add and keep operations.

35606 (1096378) -- Canceling an update within the GUI does not stop the server task

In this release, when a lengthy update operation is canceled, the server is more responsive and the
update task will not continue to run.

37085 (1095195, 1101666) -- Read the count of unaffiliated changes when displaying active
issues in the Stream Browser

Only the count of unaffiliated changes are now read when displaying active issues in the Stream
Browser. This improves performance in streams with large numbers of unaffiliated changes. In
addition, if the "Short Description” field is displayed, we include the count of unaffiliated changes.

37206 (1099163) -- Failed login attempts still put user name in acserver log

The server log no longer prints the username if the login command fails. This addresses the problem of
when users accidentally try to login using their password rather than username, the END statement
would display this password.

37302 (1099335) -- Diff of child xlinked directory in an xlinked directory crashes server
The issue has been resolved in this release.
37527 (1097286) -- SIGABRT crashes in promote and dispatch query
Resolved the crash in the execution of the trigger.
38661 -- Fix popup menu rendering problem on Linux Virtualized environments
BizLaf translucent popup menus now render correctly on Linux in Virtualized environments.
35739 (1096534) -- AccuRev client crash on Windows 8 after idling for long time

After the GUI sits idle for several hours, when attempting to restore the window, the client might crash.
This has been fixed in the current release.

38741 (1094754) -- AccuRev diff -b -v produces different results depending on current
directory

In this release, allow diff -b -v to work by stream ID if in a workspace, even if the file being diff’ed
does not actually exist in the workspace. Also, as long as the workspace is in the same depot as the
stream, and the file exists in the stream specified by ID, allow diff -b -v.

38757 (1096285) -- Linux permissions on workspace gets set to rw-r--r-- on merged files

The existing file permissions are preserved following the merge of a file.
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38762 (1096357) -- Incorrect error generated when using -t with dates for a diff

An error message "Transaction ‘trans#' is out of range™ appears now instead of "You are not
authorized..."

38764 (1098124, 1098936) -- Enhanced log rotation

Two new variables are now available in the acserver.cnf file - LOG_KEEP_DAYS and
LOG_KEEP_SIZE.

LOG_KEEP_DAYS is the number of days to keep the log file, and ranges from 1 to 30 days. If this
field is not given, logs are rotated every 7 days.

LOG_KEEP_SIZE is the size (in megabytes) that the log file can grow to before it is rotated out. The
range for this is 10MB to 1000MB (1 GB) and if this field is not given, then the log is not rotated by
size.

38765 (1098474) -- Two segfault crashes for accurev_server
segfault no longer crashes when running tasklist command.

38767 (1096863) -- Error during dbupgrade processing duplicate key value
site_property_pkey

Fixed update SQL query to prevent duplicate keys.

38771 (1099287) -- Invalid stream name error message appears during show stream
command

The correct error message "Stream <name> is not workflow enabled." now appears.
38772 (1099799)-- AccuRev info -fx option
Added support for an XML output of the info command.
38867 (1099098) -- Fix return value on promote when no valid elements
Promote now returns 1 (error) when no valid elements were selected to promote.

38881 (1096381) -- XML tasks not being removed from the AccuRev Server's task list when
they are cancelled

Improved thread interruption handling to be more responsive.
38905 (1094769) -- Ability to copy and paste transaction number from history view
Transaction numbers can now be copied from any history view in the GUI.

39013 (1094718) -- Write default layout XML to preferences file when user presses new
"Reset Layout" button

Users can restore the original default layout in the GUI.

38958, 38959 (609969, 609970) -- cpkremove appears to removes file from change package
even though trigger fails

In this release, resolved return value of the cpkremove command. If the preop trigger fails, the
command fails. If the trigger outputs an errors message, it is displayed in the GUI.

39037 (1096816) -- AccuWork issue attachment corruption

When saving an attachment using cut and paste of a fully qualified file path that is incorrect or
inaccessible, attachments become corrupted. This has been fixed in the current release.
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39049 (1101735) -- 6.2.1a does not install a replica server
Replaced missing steps to install a replica server.

39051 (1101744) -- Server process fork/clone not necessary when process will be replaced
by some other program (Perl/Trigger)

The server now makes use of vfork when launching external programs (diff, triggers).

39098 (1101879) -- COMPRESSION_ENABLED=TRUE caused error after replica sync when
adding new workspace

Creating new workspaces when using compression through a replica now works correctly.
39115 (1099837) -- Set initial heap and max heap size java settings

The installer now sets better defaults for the initial and max heap size in Java, yielding improved GUI
performance, especially during merge and patch.

39172 -- Promote by issue with timebasis and non up-to-date workspace broken

If a time basis is added to the backing stream and the workspace is not subsequently updated, promote
by issue containing files modified after the backing stream change fails to promote by issue correctly.
This has been fixed in the current release.

39181 -- Replica protocol failures with compression_enabled in revert and dispatch pass
through commands

There were several protocol mismatches in replica mode when COMPRESSION_ENABLED=TRUE.
All replica pass through commands try to compress files being transferred when the only ones that
should are keep and add when sending files from the client to the server. This has been fixed in the
current release.

Known Issues

This section describes known issues in AccuRev and in the AccuRev Web Ul. Refer to the Known Issues
sections from previous releases for other known problems and workarounds.

Known Issues in AccuRev
Graphical AccuRev installation may hang on Solaris 11

On Solaris 11, the graphical AccuRev installation may hang if you attempt to cancel the installation.
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AccuRev 6.2.1a Release Notes

This chapter describes changes and other information related to AccuRev Version 6.2.1a (AccuRev
6.2.1a).

Deprecated Features

The following features are deprecated in AccuRev 6.2.1a and will not be supported in a future release:

» Due to the upgrade to Java 1.8 JRE, AccuRev 6.2.1a no longer supports 32-bit Solaris environments
(both x86 and Sparc).

The following features are deprecated in AccuRev 6.2.1 and will not be supported in a future release:

= Starting with AccuRev 6.2.1, there is no AlX installer and GUI available. The AIX client binaries are
available and must be manually installed by accurev-6.2.1-aix-clientonly-binaries.zip.

The following feature is no longer supported in AccuRev 6.2.1:
» The integration between the AccuRev Web Interface and Atlassian Crucible versions prior to 3.x.

Note: If you are using Crucible 3.0 or later, you can add AccuRev contents to a Crucible review by
using the AccuRev Plug-In for Atlassian Crucible, which is available at the
http://supportline.microfocus.com/websync/productupdatessearch.aspx site.

The following features are no longer supported in AccuRev 6.2:

= Starting with AccuRev 6.2, the automatic client upgrade feature has been changed. After the
installation of the AccuRev server software, the administrator can choose to download the AccuRev
client installers needed at their site. See Using Client-only Install Packages for more information.

= AccuRev version 6.2 does not support the HP-UX platform.

» The :<issue-number>argument for the revert command. Due to the introduction of variants in
AccuRev 6.0, this argument is no longer necessary and is ignored if invoked -- when you revert an
issue, AccuRev now assigns changes automatically to a variant of the original issue. (Revert variants
are highlighted in red in the AccuRev GUI.) Please update any scripts that use this argument so they
will not break when support for this argument is removed.

The following feature was deprecated in AccuRev 6.0 and is no longer described in the user
documentation. It will not be supported in a future release:

= Transaction-level integration. Previously one of two integrations available between AccuRev SCM
and the AccuWork issue tracking system. Please use change package-level integration, as described in
The Schema Editor appendix of the AccuRev On-Line Help Guide. Any scripts that make use of
transaction-level integration should be updated so they will not break when support for transaction-
level integration is removed.

The following features were deprecated in AccuRev 5.7 and are no longer supported:

= ACCUREV_IGNORE_ELEMS environment variable. Use the .acignore file to specify ignore patterns in
AccuRev.
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= So called traditional, server-based Timestamp Optimization (TSO). AccuRev now uses local, client-
based TSO exclusively. As part of the change to the local, client-based TSO algorithm, the following
features were also deprecated:

= -O2 option for anchor, co, files, stat, and update CLI commands.
» The stat_mode variable in the acserver.cnf configuration file.

= Stream datatype (deprecated in AccuRev 5.5). The Stream datatype was introduced to support
AccuWorkflow and is no longer needed.

In addition, the style stream property introduced in AccuRev Version 6.0 is no longer supported; it has
been replaced with the streamStyle property. When you upgrade to Version 6.1, AccuRev automatically
migrates all occurrences of style to streamStyle, but any external scripts you might be using -- to change a
stream’s color based on an event, for example -- will have to be updated to use the new streamStyle name.

Changes in AccuRev Release 6.2.1a

AccuRev Release 6.2.1a includes the following new features and bug fixes.

Note: In cases where an issue is identified with two numbers, such as 25296 (1095910), the first
represents the issue number in the AccuWork issue tracking system; the second, in parentheses, is the
issue number in the SupportLine system used by Customer Care.

33775 (1095572) -- Using the Search Workspace function while in the root folder causes
AccuRev to hang

With Linux clients, the AccuRev workspace explorer hangs when a user tries to search any element or
folder from within the root folder using the "Search workspace" function.

This has been fixed in the current release.
38649 -- setpref inserts additional newlines into preferences.xml

When using setpref, additional newlines appear in preferences.xml. This reduces the readability of the
XML, but had no functional effect.

This issue has been fixed in the current release.
37091 -- The Java Runtime Environment (JRE) has been upgraded to 1.8

In this release, the Java Runtime Environment has been upgraded to 1.8. See deprecation due to this
upgrade listed above.

37597 (1100260) -- Viewing stream issues performance is incredibly slow

There was an issue where multiple patches appear to have severely impacted issuelist performance.
The performance is from having a patch of a patch of a patch. Every stream where the file(s) is still
active after the first patch will exhibit the problem. Also, anyone who adds another version of this
file(s) to an issue will cause the problem to reappear in whatever stream the user promotes to. This has
been resolved by refactoring and building the in-memory version tree to perform significantly faster
and more efficiently.

38677 (1100620) -- Change Package History does not display transaction details

The Change Package History window did not display the details of a selected transaction. This has
been fixed in the current release.
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38683 -- Encoding errors changed the permission of the destination

When attempting to pop/update a file with a name that can not be encoded by the local file system's
locale, after failing with an appropriate error message, the execute bit is removed from the permissions
of the workspace top or destination directory.

This issue has been fixed in the current release.
38719 (1100434, 1100753) -- Client upgrade installer for Mac OS X

The 6.2.1a client now properly downloads the OS X specific client only installer package. Users
upgrading from prior releases will still be required to perform a manual upgrade one time to 6.2.1a.

38721 (1100736) -- Updating a workspace causes a core dump in 6.2.1 on AIX

The client side TSO database schema was upgraded in 6.2.1. This happens automatically to the TSO
database when a workspace is updated.

On AIX platforms only, upgrading pre-6.2.1 TSO databases crashes.
This issue has been fixed in the current release.

38808 -- Poor performance when promoting against a Change Package with many
elements or versions

When promoting an element out of a workspace against a CPK with thousands of elements/versions,
performance is noticeably poor.

This issue has been fixed in the current release.

23153 (1097281, 1099639) -- Annotate takes more time in GUI (1097281); Annotate on a
particular file produces a network error (1099639)

Annotate has been refactored to improve performance and complete successfully on files with many
revisions.

Known Issues

This section describes known issues in AccuRev and in the AccuRev Web Ul. Refer to the Known Issues
sections from previous releases for other known problems and workarounds.

Known Issues in AccuRev
AccuRev GUI may have display issues with some Linux virtual machines
These display issues may include black pop-up menus, with no text visible.
To correct this problem, add the following line to the acgui.lax file to turn off translucent windows:
lax.nl.java.option.additional=-DCezanne.windowTranslucencyEnabled=false
Then launch the AccuRev GUI normally with the acgui executable.
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AccuRev 6.2.1 Release Notes

This chapter describes changes and other information related to AccuRev Version 6.2.1 (AccuRev 6.2.1).

Deprecated Features

The following features are deprecated in AccuRev 6.2.1 and will not be supported in a future release:

= Future versions of AccuRev will be upgraded to Java 1.8 JRE. As a result, 6.2.1 is the last release that
will support 32-bit Solaris environments (both x86 and Sparc).

= Starting with AccuRev 6.2.1, there is no AlX installer and GUI available. The AlX client binaries are
available and must be manually installed by accurev-6.2.1-aix-clientonly-binaries.zip.

The following feature is no longer supported in AccuRev 6.2.1:
» The integration between the AccuRev Web Interface and Atlassian Crucible versions prior to 3.x.

Note: If you are using Crucible 3.0 or later, you can add AccuRev contents to a Crucible review by
using the AccuRev Plug-In for Atlassian Crucible, which is available at the
http://supportline.microfocus.com/websync/productupdatessearch.aspx site.

The following features are no longer supported in AccuRev 6.2:

= Starting with AccuRev 6.2, the automatic client upgrade feature has been changed. After the
installation of the AccuRev server software, the administrator can choose to download the AccuRev
client installers needed at their site. See Using Client-only Install Packages for more information.

= AccuRev version 6.2 does not support the HP-UX platform.

= The :<issue-number> argument for the revert command. Due to the introduction of variants in
AccuRev 6.0, this argument is no longer necessary and is ignored if invoked -- when you revert an
issue, AccuRev now assigns changes automatically to a variant of the original issue. (Revert variants
are highlighted in red in the AccuRev GUI.) Please update any scripts that use this argument so they
will not break when support for this argument is removed.

The following feature was deprecated in AccuRev 6.0 and is no longer described in the user
documentation. It will not be supported in a future release:

= Transaction-level integration. Previously one of two integrations available between AccuRev SCM
and the AccuWork issue tracking system. Please use change package-level integration, as described in
The Schema Editor appendix of the AccuRev On-Line Help Guide. Any scripts that make use of
transaction-level integration should be updated so they will not break when support for transaction-
level integration is removed.

The following features were deprecated in AccuRev 5.7 and are no longer supported:

" ACCUREV_IGNORE_ELEMS environment variable. Use the .acignore file to specify ignore patterns in
AccuRev.

= So called traditional, server-based Timestamp Optimization (TSO). AccuRev now uses local, client-
based TSO exclusively. As part of the change to the local, client-based TSO algorithm, the following
features were also deprecated:
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= -02 option for anchor, co, files, stat, and update CLI commands.
= The stat_mode variable in the acserver.cnf configuration file.

= Stream datatype (deprecated in AccuRev 5.5). The Stream datatype was introduced to support
AccuWorkflow and is no longer needed.

In addition, the style stream property introduced in AccuRev Version 6.0 is no longer supported; it has
been replaced with the streamStyle property. When you upgrade to Version 6.1, AccuRev automatically
migrates all occurrences of style to streamStyle, but any external scripts you might be using -- to change a
stream’s color based on an event, for example -- will have to be updated to use the new streamStyle name.

Changes in AccuRev Release 6.2.1

AccuRev Release 6.2.1 includes the following new features and bug fixes.

Note: In cases where an issue is identified with two numbers, such as 25296 (1095910), the first
represents the issue number in the AccuWork issue tracking system; the second, in parentheses, is the
issue number in the SupportLine system used by Customer Care.

14752 -- Need a way to stat element by EID
The stat command now takes -e <eid> parameter.
29587 (1096963) -- Need to clean up .ac_ws_stats.db from time to time

The TSO database no longer explicitly stores all external files. The first time the TSO database is
accessed, all external files will be removed and only the parent level directories will be stored in the
TSO database.

33882 (1095872) -- AccuWork schema cannot add over 200 Increase max fields supported
for AccuWork fields

The AccuWork schema now supports 500 fields.

33993 (1096582) -- AccuRev update to a transaction ID does not work on a new workspace
Added support to updating to an older transaction time than the current update transaction.

34057 (1094702) -- diff streams by file not accurate due to evil twin

When an eid is hidden by an evil twin, stream diff needs to act like that eid was not found instead of
accidentally comparing it against a different element that happens to have the same name.

34963 (1095795) -- Inability to promote stranded files

In previous versions, it was possible to promote a stranded file up through the stream hierarchy. This
functionality, broken in v6.1, has been restored.

35292 (1096128) -- AccuRev diff -a -i -v stream -V stream shows wrong results

When an element is hidden by a twin or is defuncted in one stream and is either not found, defuncted,
or hidden by a twin in the other stream, AccuRev incorrectly stated that there is an important
difference in the element between the two streams. In those above cases, AccuRev will not consider
the elements to differ anymore.

35511 (1096306) -- Include putconfig and getconfig under the server admin trigger

Added getconfig support to the server_admin trigger. putconfig was already supported in previous
versions.
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35713 (1096613) -- ac promote -t -d does not work

Fixed the promote command such that if an element in a transaction or in the default group at a
transaction (-d -t) that has been promoted into the backing, the element will not be promoted again.
This allows the transaction that contains an overlap element to be promoted if the overlap element has
been merged and promoted separately.

35714 (1096495) -- stat -t erroneously reports no such elem
stat -t in a workspace was not correcting the stream hierarchy for the workspace's current update level.

35811, 4015, 5193 (1096582, 1096119, 1096121, 1099796) -- AccuRev update to a
transaction ID does not work on a new workspace

The update command can now take -t parameter that is older than the current workspace or reftree's
update transaction to enable rolling back an update in a workspace or reftree. This transaction,
however, has a floor of backing stream's creation transaction. Attempts to update to a transaction
before the backing stream was created will give 'transaction out of range' error.

However, elements that have been added/kept and promoted from a workspace will not be rolled back
when updating the workspace to an older transaction. The best practice for updating to an older
transaction is to use a reftree or a newly created workspace.

As part of this work, update -s <stream> -t <t1>-<t2> syntax now works correctly. Use of the keyword
‘now’ or ‘highest' for t1 or t2 in update will not cause server crash anymore. Furthermore, the output of
update -s -t will list changes going from t1 to t2, rather than the prior behavior that goes from t2 to t1.

36138 (1097061) -- Automatic AccuWork issue update
AccuWork issue Schema Editor has been modified so that a new "Force manual merge on save
conflict” check box has been added to the Schema tab. When this box is selected, users are forced to
merge their edits with the latest saved issue record when their edits are based on stale AccuWork issue

records. The option to override the latest Accuwork issue record with stale user edits is prevented by
this option.

36176 (1097118) -- Searching for a file in workspace explorer should display feedback to
user

Long searches now display a progress dialog, allowing the user to cancel the search.

36227 (1097243) -- AccuRev does not allow "update -t" when there is an overlapped file
beyond the target transaction

The Update command now sees modified non-member elements at the specified transaction level, not
beyond it.

36311, 36326 (1097305) -- AccuRev issuelist -3 returns AccuWork issue numbers rather
than 3rd party number

In previous releases, the AccuWork issue number was always listed in the issuelist (hon XML) output.
If the -3 argument is specified, the issuelist command will now output the 3rd party key values.

36322, 34674 (1095401) -- AccuRev cores during 'accurev fetch' command in WebUI

All crashes in cat, and name commands are fixed. The WebUI is fixed to pass the correct element name
for the diff overlapping changes options.
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36416, 37137 (1097467) -- Cannot revert a transaction, revert caused zero length files

Revert of a transaction that contains a new file or the initial version in the stream will cause the file to
be defuncted. The revert command was fixed so that the defuncted file would not have empty content
anymore.

36730 -- GUI: show issues in the upper pane of history view

The issue number and third-party key are now displayed in columns in the upper pane of the history
view and the active transactions view.

36731 (1094663) -- Find file location directly from searches or unify context menu

Items in the search results panel of Workspace Explorer have a new context menu option "Go to Parent
Folder => In Workspace Explorer"”, which enables the user to quickly navigate to the selected item in
the Workspace Explorer's file tree.

36732 -- GUI: From Workspace Explorer, open OS-specific file manager to appropriate
folder

Items in Workspace Explorer and in the search results panel of Workspace Explorer have a new
context menu option "Go to Parent Folder => In OS File Manager", which enables the user to open an
OS-specific file manager to the folder containing the selected item. The item must have a status other
than "defunct™” or "missing”. This feature is available on Windows, Linux, Solaris, and Mac.

36943 -- GUI: Additional support for multiple GUI instances

AccuRev 6.2.1 offers additional support for multiple, concurrent GUI instances by tiling the splash/
login screens so that they do not overlap. The environment variable ACCUREV_GUI_INSTANCE
dictates the placement of the GUI instance's splash/login screen. The GUI can display up to 4 tiled
splash/login screens. Any instances over 4 will overlay one of the first 4.

Also, AccuRev 6.2.1 stores server-specific location preferences for the main AR window. If a user
regularly works with two concurrent GUI instances that talk to different servers, s/he can position the
two main windows in different areas of the screen, and AccuRev will remember these locations for
subsequent logins to those servers.

37014 (1098058) -- Cl builds fail for simultaneous promotes

Two or more simultaneous pops in the same target directory would randomly fail. This has been fixed
so that each pop uses distinct temporary files to receive data from the server and do not collide with
other pops.

37104, 30728 (1099553) -- accurev_server crash when client does diff -v -V

The check for an eid under a given location was incorrectly modifying the cross link table and has been
fixed.

37130 (1099011) -- Replica sync fails when COMPRESSION_ENABLED=TRUE

First, the unzip buffer was not tracking the actual size of the files as it unzipped. Secondly, due to the
nature of the merge_prep call, without a protocol change the master server never sends the file content
compressed even if compression is enabled. Therefore, for merge and patch, the client can not try to
decompress that content. Only replica sync, replica fetch, add and keep are able to use compression
(including the keep of the merge result). Third, for file compression we were attempting to compress
and decompress more than just the content of the file in some cases. The buffered streaming protocol
resulted in a random amount of data being read from the wire and placed in an internal input buffer.
Sometimes that data could include more than the file content. Only the file content itself is
compressed, so we have to make sure not to try decompressing any of the non-file-content data.
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37148 -- GUI: Add Open Issues to context menu of rows in upper pane of History View

"Open Issues” has been added to the context menu of rows (transactions) in the upper pane of the
history view. This functionality was supported previously in the lower pane of the history view; now it
is also available in the upper pane.

37274 (1099302)-- Core Dump on user promote with empty 3rd party issuenum

"Specifying an empty issue number (or 3rd party issue number) when promoting elements will work
successfully.

37301, 32134 (1099336) -- Invalid xlink crashes the server
Fixed by stopping the backing stream walk before it reaches the root stream.

37379, 35640 (1096417) -- Pass the transaction IDs to the server trigger to enforce
promotion by transaction

Adds transaction XML node with transaction I1Ds as an argument to the trigger file if a promote by
transaction is done.

37438 -- GUI doesn't remember a user's own stream favorites, private or public, when
moving to a stream browser tab that was present, but not open, at GUI startup time

The problem has been resolved in this release.

37450 -- GUI: Add "Go to Parent Folder => In Workspace Explorer" for elements in
Outgoing and Conflicts modes

Items in the Outgoing and Conflicts modes of the File Browser have a new context menu option "Go to
Parent Folder => In Workspace [Stream] Explorer", which enables the user to quickly navigate to the
selected item in the Workspace Explorer or Stream Explorer.

37521, 6073, 21092, and 21497 (1095628) -- error validation on "write_schema" do not
return to server_admin_trig

Error messages output by the server_admin trigger will now be reflected to the user.
37541 -- The installed Java version was upgraded from 1.6 to 1.7

Previous versions of AccuRev installed the Java 1.6 JRE. 6.2.1 installs Java 1.7 JRE. Refer to Known
Issues for workaround if you encounter display issues on Linux virtual machines.

37546 (1100112) -- More frequent automatic restart by AccuRev master server crashes on
dropped connection timeouts doing replica fetches

The server is no longer shut down when a communication timeout occurs with the replica server.

37593 (1100044) -- problem with IssuelList command: Network error - 6: Connection lost
while receiving database

Issuelist commands against the root stream of a depot now complete successfully.

Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 6.2.1 documentation.

37416 (1099360) -- Update the lists of transactions for hist -k in CLI Help and XML output
reference

The hist command in the CLI User's Guide and XML Output Reference hist command list do not
match. The two lists are not supposed to be redundant, since the hist -k <transaction -kind> command
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list is of the transaction kinds that are displayed, while the XML output list is of the transaction kinds
that return a list of elements, which is different. Not all of the transaction types that are displayed have
affected elements. Both lists were updated to reflect current functionality in 6.2.1.

Changes in AccuRev Web Ul Release 6.2.1

AccuRev Web Ul Release 6.2.1 includes the following changes:

32309 (609968) -- Creating new issue in WebGUI is slow due to show groups on all active
groups

When initially loading the issue schema, calls to show members of all groups in the system were being
made. This has now been optimized to prevent unnecessary calls, so that screens such as "New Issue"
initialize faster.

36322 (1095401) -- Diff overlapping changes options don't work in WebUI and crash
AccuRev server

The WebUI is fixed to pass the correct element name for the diff overlapping changes options.

Known Issues

This section describes known issues in AccuRev and in the AccuRev Web UI. Refer to the Known Issues
sections from previous releases for other known problems and workarounds.

Known Issues in AccuRev
AccuRev GUI may have display issues with some Linux virtual machines

To correct this problem, install JRE 1.6 and add the <installed path>/jre/bin to your PATH environment
variable. Rename or remove the JRE directory in the AccuRev install directory.

AccuRev 6.2.1 does not provide a client upgrade installer for the Mac OSX
Mac OSX users need to run the accurev-6.2.1-macosx-clientonly.zip in order to install AccuRev 6.2.1.
35370 -- CLI commands issued to wrong server after user attempts login and cancels

In previous releases, if a GUI user attempted to log in to a different server but then clicked the Cancel
button in the login dialog box, subsequent CLI commands were issued to the new server instead of the
original server. This problem has been corrected in release 6.2.

This fix impacts how users manage the list of available AccuRev servers. If you remove the server that
you are currently logged in to from the list of available servers in the Available AccuRev Servers
dialog box, then after clicking the OK button, you must immediately log in to a different server instead
of clicking the Cancel button in the Log in to AccuRev Server dialog box. Otherwise, the current
server will remain in the list of available AccuRev servers.

35395 -- Stream Favorites selection not retained when upgrading to AccuRev 6.2

After upgrading to AccuRev 6.2, the AccuRev GUI does not retain the user’s most recent Stream
Favorites selection. Stream Favorite definitions created prior to 6.2 are preserved.

36582 -- The documentation incorrectly describes HP-UX as a supported platform

Chapter 14, Using Client-only Install Packages, of the AccuRev Administrator’s Guide incorrectly lists
HP-UX as a supported platform. Support for HP-UX is deprecated.
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AccuRev 6.2 Release Notes

This chapter describes changes and other information related to AccuRev Version 6.2 (AccuRev 6.2).

Deprecated Features

The following feature is deprecated in AccuRev 6.2 and will not be supported in a future release:
» The integration between the AccuRev Web Interface and Atlassian Crucible versions prior to 3.x.

Note: If you are using Crucible 3.0 or later, you can add AccuRev contents to a Crucible review by
using the AccuRev Plug-In for Atlassian Crucible, which is available at the
http://supportline.microfocus.com/websync/productupdatessearch.aspx site.

The following features are no longer supported in AccuRev 6.2:

= Starting with AccuRev 6.2, the automatic client upgrade feature has been changed. After the
installation of the AccuRev server software, the administrator can choose to download the AccuRev
client installers needed at their site. See Using Client-only Install Packages for more information.

= AccuRev version 6.2 does not support the HP-UX platform.

= The :<issue-number> argument for the revert command. Due to the introduction of variants in
AccuRev 6.0, this argument is no longer necessary and is ignored if invoked -- when you revert an
issue, AccuRev now assigns changes automatically to a variant of the original issue. (Revert variants
are highlighted in red in the AccuRev GUI.) Please update any scripts that use this argument so they
will not break when support for this argument is removed.

The following feature was deprecated in AccuRev 6.0 and is no longer described in the user
documentation. It will not be supported in a future release:

= Transaction-level integration. Previously one of two integrations available between AccuRev SCM
and the AccuWork issue tracking system. Please use change package-level integration, as described in
The Schema Editor appendix of the AccuRev On-Line Help Guide. Any scripts that make use of
transaction-level integration should be updated so they will not break when support for transaction-
level integration is removed.

The following features were deprecated in AccuRev 5.7 and are no longer supported:

" ACCUREV_IGNORE_ELEMS environment variable. Use the .acignore file to specify ignore patterns in
AccuRev.

= So called traditional, server-based Timestamp Optimization (TSO). AccuRev now uses local, client-
based TSO exclusively. As part of the change to the local, client-based TSO algorithm, the following
features were also deprecated:

= -O2 option for anchor, co, files, stat, and update CLI commands.
» The stat_mode variable in the acserver.cnf configuration file.

= Stream datatype (deprecated in AccuRev 5.5). The Stream datatype was introduced to support
AccuWorkflow and is no longer needed.
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In addition, the style stream property introduced in AccuRev Version 6.0 is no longer supported; it has
been replaced with the streamStyle property. When you upgrade to Version 6.1, AccuRev automatically
migrates all occurrences of style to streamStyle, but any external scripts you might be using -- to change a
stream’s color based on an event, for example -- will have to be updated to use the new streamStyle name.

Changes in AccuRev Release 6.2

AccuRev Release 6.2 includes the following new features and bug fixes.

Note: In cases where an issue is identified with two numbers, such as 25296 (1095910), the first
represents the issue number in the AccuWork issue tracking system; the second, in parentheses, is the
issue number in the SupportLine system used by Customer Care.

12223, 34865 (1095285) -- Include and exclude rules should affect show issues and issue
diffs

In previous releases, the user’s current include, exclude, and cross-link settings were not reflected
when showing diff by issue between two streams. This problem has been corrected in the current
release. The process takes longer to execute for streams that have cross-links as a result of the
additional computation of the rules.

14752 -- New: Ability to stat by element ID

The stat command shows the AccuRev status of elements or file system objects. Users can now select
a file element by using the -e command to specify the element-ID (eid). The ability to stat elements by
eid, rather than by specifying the name of the element, is useful for certain operations, such as tracking
down stranded elements. If specified, the -e option takes precedence over other options.

24205, 36075 (1095020) -- Special characters in Postgres superuser password cause
installation to fail

In previous releases, special characters in the Postgres superuser password caused an AccuRev
installation to fail. This problem has been corrected in the current release and the AccuRev installer
now supports special characters.

24263, 33992 (1094959) -- New: rebase CLI command

The rebase command purges elements in your default group when you want to allow inheritance,
resolve underlaps, or purge stranded elements. When you perform a rebase operation, AccuRev purges
elements from a stream or workspace when the current version of the element is the same as what is in
the backing stream, underlapped with the backing stream, or stranded. In addition, a --rebase option
has also been added to the purge command. See the CLI reference documentation for more
information.

24280 (1094954) -- A time-based stream incorrectly hides overlap status

In cases where a stream’s hierarchy was changed after the current stream's time basis, overlapped files
did not show an overlap status until the stream’s time basis was removed. This problem has been
corrected in the current release.

24615 (1094647) -- The login command does not fail when a session file cannot be created

The login command incorrectly returned a successful exit code of "0" when ACCUREV_HOME was
set to a non-existent directory and login failed because a session file could not be created. This
problem has been corrected in the current release.
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25296 (1095910) -- Revert by transaction in stream not working in the GUI

When reverting by transaction within a stream in the GUI, AccuRev incorrectly displays a warning
message that reads "Invalid format for -t option™ which blocks the revert operation. This problem has
been corrected in the current release.

33928 -- New: The ability to use gated streams

A gated stream is a new stream type that allows you to set rules that determine whether changes
promoted into the stream can be promoted out of it. These rules, which are set using AccuRev triggers,
can be based on passing externally established criteria, like code reviews, test suites, and builds, for
example. See Chapter 11, Using Streams to Enforce Process, in the AccuRev Administrator’s Guide for
more information.

33996, 35713 (1096613) -- New: The ability to demote changes

The demote option provides users with the ability to remove changes that have been promoted to a
stream while still retaining those changes in a child stream or workspace. The demote operation allows
you to "undo” changes in the same ways in which you can promote them: by issue, transaction, or file.
For more information, see the CLI reference documentation and the section called, Demote: Moving
Elements Out of a Stream, in Chapter 3, The File Browser, of the AccuRev Online Help.

34077, 34078 (1094823) -- When the name command returns an error, the GUI fails to alert
the user

When the name command failed to return an element name during a merge operation, the GUI did not
alert the user and the merge failed silently. This problem has been corrected in the current release as
the GUI no longer fails silently.

34346 (1094905) -- Web Ul returns the wrong version of a cross-linked element in a
snapshot

Performing a Save As operation in the Web Ul on an element link in a snapshot returned the wrong
version if the original file had been changed. This problem has been corrected in the current release.

34357 (1094921) -- Writing to acserver.log for a nhame command causes a segmentation
fault

A segmentation fault occurred when AccuRev attempted to write an "end" statement for a name
command in acserver.log. This problem has been corrected in the current release.

34366 (1094927) -- Performance degrades for Merge and Patch operations for issues with
numerous elements

In previous releases, performance degraded for a merge or patch operation in an issue-based Change

Palette when an issue had numerous elements. This problem has been corrected in the current release.
34682, 36548, 36602 (1095481) -- Merge and Patch performance in the GUI has been
improved

The performance of Merge and Patch operations in the GUI has been optimized to reduce the number
of calls made between the client and the server, and between the GUI and the CLI.

35064, 35719, 36634 (1096496) -- StreamBrowser performance has been improved

In previous versions, users occasionally experienced some delays when displaying streams in the
StreamBrowser. The performance of the StreamBrowser has been improved in the current release.
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35174 (1096051) -- Cross-promoting issues from stream to workspace fails when files
have moved

In previous releases, cross-promoting an issue from a stream to a workspace failed when the files in the
issue were located in a different directory in the workspace. This problem has been corrected in the
current release.

35908 -- New: ACCUREV_SERVER environment variable

The ACCUREV_SERVER environment variable specifies the AccuRev Server that the AccuRev GUI
connects to when the GUI is started, allowing multiple instances of the AccuRev GUI to connect to
different servers. See the CLI reference documentation for more information.

35919 -- License agreement during a console install requires review of multiple pages

In previous releases, users performing a console installation were required to page through more than
50 pages of the licence agreement information. This problem has been addressed in the current release
and users can now accept the license agreement on the first page.

36031 (1097268) -- Changing the time basis of a stream and then changing include or
exclude rules produces an error

In previous releases, changing the time basis of a stream and then attempting to change include or
exclude rules for that stream produced an error stating *No element named" because AccuRev could
not find the elements specified. This problem has been corrected in the current release so that AccuRev
now finds the elements and no longer produces an error under these conditions.

Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 6.2 documentation.

33235 -- Documentation missing for the "defcomp" option of the hist command

In previous releases, the online Help did not contain an explanation for the defcomp option of an
accurev hist -k defcomp command. A description of the defcomp option has been added to the online
Help in the current release.

33835 -- New: A chapter has been added to the CLI User's Guide for the XML output of
AccuRev commands

A new chapter has been added to the CLI User's Guide which documents the XML output for the hist
and Isrules commands. See XML Output Reference for more information.

33942 -- Documentation missing for replaceAll and bulk update for modifylssue in XML

In previous releases, the AccuRev CLI User’s Guide did not contain descriptions of the replaceAll
attribute or bulk update that may be used with modifylssue XML to modify AccuWork issues.
Descriptions of the replaceAll attribute and bulk update have been added the CLI User’s Guide.

34340 (1094898) -- Incorrect documentation for "Add Text control”

In previous releases, the online Help for the AccuWork Schema tab described an Add Text control
option for the Log field which did not exist. The documentation for the Schema tab help has been
revised in the current release.

34390 (1094957) -- Documentation for undoing a purge has been improved

In previous releases, the documentation in the AccuRev CLI User’s Guide that described the process of
undoing a purge was unclear. The description of this process has been clarified in the CLI User’s Guide
in the current release.
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34812 (1095533) -- Documentation for the CLI setproperty command has been improved

A new section has been added to setproperty command in the AccuRev CLI User’s Guide that
describes the process of escaping reserved characters.

34914 (1095733) -- Documentation did not specify that files could not be cross-promoted
by drag and drop

The AccuRev 6.0 Installation and Release Notes Guide stated that users could perform a cross-
promote by dragging and dropping items from a dynamic stream to the destination stream without
indicating that this is only true of issues and not files. This error has been corrected in the current
release.

35481 -- New: Documentation for gated streams

A new chapter describing how to set up and use gated streams has been added to the AccuRev
documentation. See Chapter 11, Using Streams to Enforce Process, in the AccuRev Administrator’s
Guide for more information.

35845 (1096619) -- Documentation describing the server_admin_trig trigger has been
improved

The documentation about the relationship between the server_admin_trig trigger and the mksnap and
mkstream commands in the Administrator's Guide has been clarified in the current release.

35887 -- Documentation describing client-only install packages has been revised

Starting with AccuRev 6.2, the Client-only Package Download Utility is no longer available. The
documentation describing this feature has been revised, as AccuRev users can still use the Upgrade
Client feature if the client-only packages are accessible on the AccuRev Server. See Chapter 14, Using
Client-only Install Packages, in the AccuRev Administrator’s Guide for more information.

35962 (1096745) -- Documentation for backing up replica sites has been improved

The AccuRev Administrator’s Guide has been revised to specify that replica sites should be backed up
as master servers are and that the replica backup should take place an hour before the master server
back up occurs.

Changes in AccuRev Web Ul Release 6.2

AccuRev Web Ul Release 6.2 includes the following changes:
35841 -- Display gated streams and staging stream in the Web Ul StreamBrowser

The AccuRev Web Ul has been updated so that gated streams and staging streams are represented in
the StreamBrowser. Note that creating and managing gated streams and staging streams through the
AccuRev Web Ul is not supported.

36045 -- Display Demote transactions in the Version Browser in the Web Ul

The AccuRev Web Ul has been updated to reflect demote operations in the Version Browser.
36099 -- Correctly display Patch transactions in the Version Browser in the Web Ul

The Version Browser in the AccuRev Web Ul has been updated to correctly show patch transactions.
36143 -- Correctly display Revert transactions in the Version Browser in the Web Ul

The Version Browser in the AccuRev Web Ul has been updated to correctly show revert by issue
transactions.
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Known Issues

This section describes known issues in AccuRev and in the AccuRev Web Ul. Refer to the Known Issues
sections from previous releases for other known problems and workarounds.

Known Issues in AccuRev
35370 -- CLI commands issued to wrong server after user attempts login and cancels

In previous releases, if a GUI user attempted to log in to a different server but then clicked the Cancel
button in the login dialog box, subsequent CLI commands were issued to the new server instead of the
original server. This problem has been corrected in release 6.2.

This fix impacts how users manage the list of available AccuRev servers. If you remove the server that
you are currently logged in to from the list of available servers in the Available AccuRev Servers
dialog box, then after clicking the OK button, you must immediately log in to a different server instead
of clicking the Cancel button in the Log in to AccuRev Server dialog box. Otherwise, the current
server will remain in the list of available AccuRev servers.

35395 -- Stream Favorites selection not retained when upgrading to AccuRev 6.2

After upgrading to AccuRev 6.2, the AccuRev GUI does not retain the user’s most recent Stream
Favorites selection. Stream Favorite definitions created prior to 6.2 are preserved.

36582 -- The documentation incorrectly describes HP-UX as a supported platform

Chapter 14, Using Client-only Install Packages, of the AccuRev Administrator’s Guide incorrectly lists
HP-UX as a supported platform. Support for HP-UX is deprecated.
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AccuRev 6.1 Release Notes

This chapter describes changes and other information related to AccuRev Version 6.1 (AccuRev 6.1).

Deprecated Features

The following features were deprecated in AccuRev 6.0 and are no longer described in the user
documentation. They will not be supported in a future release:

= Transaction-level integration. Previously one of two integrations available between AccuRev SCM
and the AccuWork issue tracking system. Please use change package-level integration, as described in
The Schema Editor appendix of the AccuRev On-Line Help Guide. Any scripts that make use of
transaction-level integration should be updated so they will not break when support for transaction-
level integration is removed.

» The :<issue-number>argument for the revert command. Due to the introduction of variants in
AccuRev 6.0, this argument is no longer necessary and is ignored if invoked -- when you revert an
issue, AccuRev now assigns changes automatically to a variant of the original issue. (Revert variants
are highlighted in red in the AccuRev GUI.) Please update any scripts that use this argument so they
will not break when support for this argument is removed.

The following features were deprecated in AccuRev 5.7 and are no longer supported:

* ACCUREV_IGNORE_ELEMS environment variable. Use the .acignore file to specify ignore patterns in
AccuRev.

= So called traditional, server-based Timestamp Optimization (TSO). AccuRev now uses local, client-
based TSO exclusively. As part of the change to the local, client-based TSO algorithm, the following
features were also deprecated:

= -02 option for anchor, co, files, stat, and update CLI commands.
» The stat_mode variable in the acserver.cnf configuration file.

= Stream datatype (deprecated in AccuRev 5.5). The Stream datatype was introduced to support
AccuWorkflow and is no longer needed.

In addition, the style stream property introduced in AccuRev Version 6.0 is no longer supported; it has
been replaced with the streamStyle property. When you upgrade to Version 6.1, AccuRev automatically
migrates all occurrences of style to streamStyle, but any external scripts you might be using -- to change a
stream’s color based on an event, for example -- will have to be updated to use the new streamStyle name.
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Changes in AccuRev Release 6.1.1

AccuRev Release 6.1.1 is a patch release for Version 6.1 that addresses the following issues:
33212 -- Stream column removed from the Stream Issues tab

The Stream column in the Stream Issues tab (right-click a stream and choose Show Active Issues to
display) displayed only the currently selected stream name for unaffiliated changes. Because of this
redundancy, the Stream column was removed from the Change Package Contents pane on the
Stream Issues tab to remove a possible source of confusion. Note that this column still appears in
some illustrations in the AccuRev 6.1 user documentation.

33264 -- Patched issues in destination stream not always identified

In previous releases, AccuRev did not always correctly identify patched issues that were already in the
destination stream. In these cases, the Change Palette would display previously patched issues along
with others that required patching. This problem has been corrected in the current release.

33425 -- elinks in snapshot streams work incorrectly in Web Ul

In previous releases, elinks created in snapshot streams resolved to the latest version of the file, and not
to the version of the file that existed at the time the snapshot was created. This problem has been
corrected in the current release, and the elink resolves to the correct version.

33324, 33476, 33489 -- SSL improvements

AccuRev 6.1.1 provides a number of improvements to the support for the Secure Sockets Layer (SSL)
protocol support introduced in AccuRev 6.1:

= Windows GUI clients experienced a slight (sub-second) delay when executing commands. This
delay, most noticeable when using the File Browser to browse workspaces or streams, has been
significantly reduced in AccuRev 6.1.1.

= AccuRev replica servers also experienced slower performance in environments in which SSL was
enabled. This problem has been addressed in the current release.

= The Heartbleed Bug was addressed by a new version of the OpenSSL libraries that are used to
implement this functionality.

33477 -- GUI performance affected by network latency

In recent releases, users accessing the AccuRev server over networks with high latency experienced
degraded performance when using the AccuRev GUI. This problem has been corrected in the current
release.

33488 -- Reverting a previously reverted issue makes old versions visible

In recent releases, AccuRev incorrectly made old versions of a file visible in a stream after reverting a
previously reverted issue. This problem has been corrected in the current release.

33564 -- maintain dbupgrade fails during change package conversion

In the previous release, the maintain dbupgrade command would sometimes fail during change
package conversion, displaying an error like the following:

FATAL: Unknown version: Invalid version ancestry is preventing
issueversion to cpk_version conversion

This problem has been corrected in the current release.
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Changes in AccuRev Release 6.1

AccuRev Release 6.1 includes the following new features and bug fixes:
2674, 32089, 33232 -- Change Palette functionality has been improved
The Change Palette has been modified in the following ways:

= There is now an enhanced Change Palette mode for issues. This mode provides functionality for
efficiently identifying and dealing with conflicts and issue dependencies, and then promoting the
issues into the destination stream.

= The Show Dependencies button is now available in the Issue Change Palette.

= The first four display columns (Promote, Status, Details, and Resolved in Workspace) have
been removed from the Issue Change Palette.

= Inprevious versions of AccuRev, the contents of the merge list that appear below the Issue Change
Palette were based on the contents of the Promote column. In AccuRev 6.1, the contents of the
merge list that appear below the Issue Change Palette are based on the issues that are currently
selected in the Issue Change Palette.

= After a Merge or Patch operation, AccuRev now prompts the user to Promote the issue.

7071 -- Output order of the "accurev hist -t <timestamp>-<timestamp>" command
corrected

In previous releases, the accurev hist -t - <timestamp>-<timestamp> command returned transactions
for the period specified by the <timestamp> parameters, but in the reverse chronological order. This
problem has been corrected in the current release.

14428 -- 'Diff Previous Transaction' operation generates an error

In previous versions, promoting a file multiple times to the same stream, reparenting the stream, and
then performing a Diff Against Previous Transaction operation produced an error message that read
"Previous transaction cannot be found for selected version." The problem was caused by referencing
the original backing stream instead of the current one. This error has been corrected in the current
release.

17508 -- New: support has been added for commands taking comments in the
server_preop_trig trigger script

Support has been added to the server_preop_trig trigger script for the use of comments for the
following AccuRev commands: add, archive, co, defunct, keep, In, promote, and purge. The
server_preop_trig.pl script in the <AccuRev-installation-dir>\examples directory has been updated
to include examples of the commenting capability for each of the commands.

18052 -- Incorrect error message when trying to remove reference tree

In previous versions, the attempt to remove a reference tree by a user who did not create the reference
tree returned the following message: "You specified a workspace: ref_tree_name that you did not
create. Use 'rmws' with the -s switch to force removal.” This error message was incorrect as the user
was trying to remove a reference tree and not a workspace. The error message has been corrected in the
current release.
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19191, 22175 -- The chws command sometimes failed to completely change workspace
names

In previous releases, the chws command sometimes failed to change the workspace name in both the
workspace and stream database tables, allowing the workspace name and stream to get out of sync.
This problem has been corrected in the current release.

20099 -- An accurev add -xR "" . command gives incorrect results

In previous releases, an accurev add -xR """ . CLI command produced undefined behavior because
the command does not specify a valid file or directory. This problem has been corrected in the current
version so that error-handling code now detects either an accurev add -xR ****. command or an
accurev add -xR "' command at the time that it is entered and notifies the user that the command
syntax is incorrect.

20761 -- Server startup limits number of client threads based on number of file handles

In previous releases, the number of threads available at server startup was limited based on the number
of file handles available. This limitation has been removed in the current release.

21002 -- Problem with exclude rules from source of cross-link

In previous releases, include/exclude rules related to cross-links could cause a -populate command to
fail when it should succeed in a workspace or a reftree. This problem has been corrected in the current
release.

23286 -- Stream name not passed to the server_preop_trig trigger in a Send to Issue
operation

In previous releases, the stream name was not passed to the server_preop_trig trigger when a user
performed a Send to Issue operation from a stream. This problem has been corrected in the current
release.

23287 -- Add file version information to cpkadd/cpkremove validation in the
server_preop_trig trigger

In previous versions, the information provided to the server_preop_trig trigger for a cpkadd or
cpkremove operation did not include file version information. This problem has been corrected in the
current release.

24207 -- Subtask issue enhancements

AccuWork has long supported multiple relationship types for issues, including parent/subtask
relationships (sometimes called hierarchical issues). Support for subtasks in AccuRev Version 6.1 has
been enhanced with new features such as:

= Drag-and-drop -- In previous releases, parent and subtask issue relationships could be created only
by specifying the relationship using the Link with Issue dialog box accessible from the
Relationships tab on the Issue form. In AccuRev Version 6.1, you can drag issues you want to
specify as subtasks and drop them on the parent issue in most places where lists of issues are
displayed, such as the Query Results pane.

= Multiple-level hierarchy -- In previous releases, parent/subtask relationships were restricted to a
single generation. Now you can create subtasks for issues that are themselves subtasks --
grandparent-> parent -> subtask, for example.

= Dedicated Subtasks tab -- To make subtasks easier to work with, they are now displayed on their
own tab on the Issue form. Subtasks are no longer displayed on the Relationships tab.
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27429 -- Renaming a directory using a different case creates a new directory

In previous releases, AccuRev incorrectly created a new directory when you rename an existing
directory using the opposite case (for example, renaming the directory ACME to acme). The current
directory was created as a child of the newly created directory. This problem has been corrected.

24574, 29649 -- Login access controls are not provided for the RLM Web server

In previous releases, the Reprise License Manager did not require login access controls for the
AccuRev Web server. This problem has been corrected in the current release with the use of version 10
of the Reprise License Manager.

27065 -- Replica server points to master server's WebUI

In previous releases, users attempting to invoke the Web Ul from the replica server could incorrectly
open the master server's Web Ul instead. This was possible if the AccuRev Web Ul had been installed
on both the master server and the replica server and if the settings.xml file had not yet been created on
the replica server. This problem has been corrected in the current release.

29212 -- Version Browser shows two entries for a file promoted by transaction

In previous releases, the Version Browser incorrectly showed two entries for a file that was promoted
by transaction if the file had been promoted previously. This problem has been corrected in the current
release.

29649 -- Support for Reprise License Manager 10.1

AccuRev 6.1 uses a new version of the Reprise License Manager, RLM 10.1, to enforce AccuRev
licences. Day-to-day license management is largely unaffected by use of RLM 10.1, but there are
several important changes of which you should be aware:

= RLM binaries, which used to be installed in the bin directory where you installed AccuRev, are
now installed in a dedicated rim directory at your AccuRev installation directory root (c:\Program
Files\AccuRev\rIm, for example).

= The accurev.opt file has also been moved to the dedicated rim directory.

= Access to the RLM server is now password protected. AccuRev recommends that you change the
default settings to restrict access to the RLM server.

See Chapter 12, License Management, in the AccuRev Administrator’s Guide for more information.
29918 -- AccuRev does not use a Windows virtual drive when opening a workspace

In previous releases, the workspace storage path was always used to determine the working directory
of a workspace. This behavior has changed in the following way: if a user runs an accurev chws - |
command and the new location for the workspace is a Windows virtual drive, AccuRev remembers the
virtual location. When the user later attempts to open this workspace, AccuRev will use the Windows
virtual drive as the location of the working directory if it maps to the storage location and if it is
currently accessible.

29944 -- Linux client causes a segfault error when running a cat command on an non-
existent element

In previous releases, running a cat -p depot -v "'-e " command on a Linux client produced a segfault
error. This has been corrected in the current release.
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30552 -- Promote by issue causes "unknown server error" when the workspace version
contains changes that are not assigned to an issue

In previous releases, a promote by issue operation run in the AccuRev GUI returned an "unknown
server error" when the workspace version contained changes that were not assigned to an AccuWork
issue. This has been corrected in the current release.

30757, 31987 -- New: Features to Support Continuous Integration

AccuRev Version 6.1 introduces several new features to support continuous integration in the
enterprise.

streamCustomlicon property -- The new streamCustomlcon property allows you to display

one of four build-status icons -- success, running, failed, or warning -- on any build streams in your
depot. Using predefined XML, you can customize the tooltip that appears when you hover over the
icon in the StreamBrowser; by default, the tooltip displays the build status reflected in the icon, but
you might want to add the build number or change the text -- build 1738 succeeded, for example.

In addition, a <c71ickurl>tag lets you include a URL. You might want to use this tag to provide a
link to your build software -- myBuildTool.local:8080, for example -- so users have easy access to
build artifacts or messages that might help them troubleshoot build failures.

streamStyle property -- To help support the new streamCustomlcon property, the style
property introduced in AccuRev Version 6.0 has been renamed as streamStyle. When you
upgrade, AccuRev automatically migrates all occurrences of style to streamStyle, but any external
scripts you might be using -- to change a stream’s color based on an event, for example -- will have
to be updated to use the new streamStyle name.

Internal StreamBrowser enhancements -- The StreamBrowser now reads only those
reserved properties that have a syntax of stream*. This simple change reduces the
StreamBrowser’s memory needs and improves its performance.

30901 -- New version support

AccuRev Version 6.1 adds support for the following platforms for both the AccuRev server and
AccuRev client, except where noted:

Microsoft Windows Server 2012

Linux SUSE 12+

Linux Ubuntu 12+

IBM AIX 7.1 (AccuRev client only)

Mac OS X 10.9 Mavericks (AccuRev client only)

30982 -- 6.0 client upgrade uploaded 5.7 client

For a brief time after the introduction of AccuRev 6.0, the client upgrade available on the AccuRev
web site installed the AccuRev 5.7 client. This problem was corrected.

30983 -- New: Diff Across All Segments

When users promote the same element against different issues, the element is said to contain different
segments, or versions of the element that have been promoted against a specific issue. A new option,
Diff Across All Segments, enables users to perform a diff operation on the earliest and latest versions
of the element that were promoted against a given issue. Diff Across All Segments ignores any
changes made to the element that were promoted against other issues.
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31088 -- New: Issue cloning

Cloning an issue creates a new, fully-defined issue based on an existing issue. Issues can be cloned in
most places you find issue information displayed in AccuReyv, including the Issue form and the Query
Results pane. If the original issue has attachments or has been specified as a sub-task of another issue,
you are prompted to include those attachments and establish the sub-task relationship with the newly

created issue. To help easily distinguish cloned issues, the original Short Description is prefixed with

the text [Clone of <issue number>], which you can change before saving the new issue.

31175 -- Unaffiliated changes are ordered from oldest segment to newest segment

The XML output from the issuelist command now lists unaffiliated changes (sometimes referred to as
"dark matter”) found in a stream in ascending transactional order according to the head version of the
unaffiliated segment.

31326 -- Validation set for Stream properties in the server_admin_trig trigger fails to
operate through GUI

In previous releases, no error message was displayed in the AccuRev GUI when the
server_admin_trig trigger denied an action. This problem has been corrected in the current release.

31401 -- Client-side pre-promote-trig trigger supports promote by issue

The XML input for the pre-promote-trig trigger now supports a <changePackage 1D> subelement that
takes an issue number as its argument. The XML specifying the promoting issues, 2312, 2314, and
3115 would look like this, for example:

<changePackages>
<changePackage I1D>2312</changePackage D>
<changePackage 1D>2314</changePackage D>
<changePackage ID>3115</changePackage D>
</changePackages>
31513 -- New: Support for Secure Client-Server Communication
AccuRev 6.1 supports the Secure Sockets Layer (SSL) protocol to provide encrypted communication
between AccuRev clients and servers. Once SSL has been enabled by the AccuRev system
administrator, AccuRev servers provide certificates to authenticate themselves to the AccuRev clients

that are trying to connect to them. When the certificate is accepted, AccuRev is able to establish
encrypted client-server communication.

Support for SSL in AccuRev 6.1 includes the addition of several new commands to the AccuRev CLI.
= enable_ssl

Allows users to inspect and accept (or reject) the SSL certificate. Certificates must be accepted in
order to establish encrypted communication with the AccuRev server.

= get_certificate

Allows users to obtain a new SSL certificate when the currently accepted certificate expires. Once
inspected, users must accept it to work with AccuRev.

= disable_ssl

Allows users to disable SSL for the AccuRev client in those situations in which previously
established SSL is disabled on the AccuRev server.
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In addition, a --thumbprint option for the enable_ssl and get_certificate commands allows you to
automate acceptance of SSL certificates on unattended machines.

See the CLI documentation (AccuRev CLI User’s Guide or CLI help) for more information.
31597, 32224 -- stat command performance improvements

In previous releases, the performance of the stat command used a lot of memory when sending large
list of files (accurev stat my_stream -l file_list.txt, for example), resulting in slow performance. In
addition, calculating the CRC values included all input files, not just those that were modified.

These problems have been corrected in the current release, with a significant increase in the
performance of stat’ing large lists of files.

31635 -- Attachments cannot be deleted in the AccuRev GUI

In previous releases, attachments added to an issue could not be deleted. This problem has been
corrected in the current release.

31769 -- stat -a, stat -R and files commands do not report status for a file

In previous releases, renaming a file from "fileA" to "fileB™ and then creating a new file named "fileA"
and promoting it could cause the file to appear to be missing in AccuRev. In this situation, running
AccuRev commands such as "accurev stat -a," "accurev stat -R", or "accurev files" on fileA
produced no information, and running an "accurev stat" command using the depot’s relative path
name reported the file as missing. This problem has been corrected in the current release.

31942 -- hist command behaves inconsistently when using multiple -f switches

In previous releases, the hist command sometimes failed to provide output when multiple -f switches
were used (hist -fx -fe, for example). To address this problem, the behavior of the hist command has
been changed in the current release in the following manner: if a command contains multiple -f

switches, the union of the -f switches is used so that a command such as hist -fx - fe is treated as if it

were hist -fxe.
31946 -- The history of a cross-link not showing cross-link status

In previous releases, running a hist command on a cross-link and using the -e option with an eid
returned an output in which the element did not have an cross-link status. This problem has been

corrected in the current version.
32092 -- Diff Against Backed Version hangs AccuRev GUI
In previous releases, performing a Diff Against > Backed Version operation in the AccuRev GUI on

an element of type ptext that existed in two workspaces attached to the same stream could hang
AccuRev. This problem has been corrected in the current version.

32129 -- Unknown server errors generated when promoting change packages
In previous releases, internal AccuRev server errors like the following were displayed when AccuRev
encountered an error during the promote of a change package:
Unknown server error: 1056
Unknown server error: 1049

These messages could obscure the real reason for the promote failure, making it difficult for the user to
troubleshoot. This problem has been corrected in the current release, and internal errors such as these
are no longer displayed to the user.
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32283 -- Poor GUI performance running Show Dependencies on incomplete issue

In AccuRev 6.0.2, the AccuRev GUI would slow, appearing to hang, when executing the Show
Dependencies command on an incomplete issue in a stream. Though the command would eventually
complete, the performance was unacceptable. This problem has been corrected in the current release
using a more efficient algorithm to calculate dependencies.

32324 -- Poor stat command performance on Windows

The performance of the accurev stat command on Windows degraded between AccuRev 6.0.1 and
AccuRev 6.0.2. The improved performance achieved in AccuRev 6.0.1 has been restored in AccuRev
6.1.

32387 -- UNC paths for remote reference trees caused errors

In AccuRev 6.0.2, certain AccuRev commands and triggers on reference trees on remote file systems
would fail if the reference tree location was changed from one specified with a mapped drive to one
specified using the Universal Naming Convention (UNC). In such cases, AccuRev would display the
following error:

Workspace directory on not accessible from this machine. Could not find workspace
This problem has been corrected in the current release.

32433 -- Exporting an issue generates an error
In previous releases, exporting an AccuWork issue to HTML resulted in an error like:

File error
9 >=0

This error has been corrected in AccuRev 6.1, and you can now export AccuWork issues to both
HTML and XML.

32496 -- Cannot change sort order, column width in Include/Exclude view

In previous releases, columns in the Rules pane in the Include/Exclude view could not be resized or
sorted if the AccuRev GUI was restarted after selecting this view. This problem, which affected only
workspaces, has been corrected in the current release, and the Element, Kind of Rule, and Set in
Stream columns can now be resized and sorted even after the AccuRev GUI is restarted.

32674 -- New options for cpkdescribe

The cpkdescribe command lists the elements in the specified change package -- the same content that
is displayed on the Changes tab of the specified AccuWork issue record. New options provide more
control over what information the cpkdescribe command returns.

= cpkdescribe -t

The -t option allows you to specify either a timestamp or transaction number to help you narrow
your result set to a time or transaction of interest.

= cpkdescribe --include_missing_segments

The new --include_missing_segments option lets you include missing segments in the result set
-- missing segments are excluded by the cpkdescribe command by default.

32903, 33009 -- Unaffiliated changes sometimes overlooked a version’s regular ancestry

In the previous release, if a version’s merge, patch, or revert ancestry had been assigned to an issue,
AccuRev did not consider that version to be dark matter. However, it is the regular ancestry that must
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be assigned to an issue to avoid the content gaps in promote that can result in the creation of
unaffiliated changes. This problem has been corrected in the current release.

32952 -- Versions from multiple issues were not always coalesced

In the previous release, AccuRev could not successfully coalesce versions from multiple issues if those
issues were promoted in one order to the backing stream, and then promoted in a different order to a
stream deeper in the hierarchy. The second promote would require a patch operation, after which
AccuRev would detect two version segments to promote when there was just one. This problem has
been corrected in the current release, and AccuRev now coalesces versions from multiple issues into a
single promotable segment in this situation.

32955 -- Internal-only information codes suppressed

In previous releases, AccuRev would sometimes display internal-only server-side information codes
on the AccuRev client. This problem has been corrected in AccuRev 6.1.

32956 -- cpkremove unable to remove EID from certain change packages

In the previous release, the cpkremove command was unable to remove the EID for a version segment
from a change package if that segment had merge ancestry and had been assigned to an issue. This
problem has been corrected in the current release.

32974 -- All variants included in change package history

In the previous release, AccuRev returned transaction information for only variant 0 when querying
change package history. Change package history now returns transaction information about all
variants.

33044 -- Patched and merged issues can now be promoted individually

In previous releases, AccuRev did not allow you to individually promote issues if they entered a
stream via a merge or patch operation. This problem has been corrected in the current release.

33045 -- All versions now included in change package when sending file from workspace

In the previous release, AccuRev would include only the tip (latest active) version in the change
package when a file was sent to a change package from the workspace. AccuRev now includes all
intermediate versions when a file is sent to the change package from the workspace.

34865 (1095285) -- XML issuediff and issuelist commands do not use include or exclude
rules

In previous releases, the XML issuediff and issuelist commands did not use include or exclude rules,
which meant that crosslinks were not visible to these commands. This problem has been corrected in
the current release.

Note: The performance of running an issuediff command on a stream that contains crosslinks has
degraded approximately 20% in AccuRev 6.2 when compared to previous versions.

Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 6.1 documentation.

16536 -- The description of the backup command in the documentation requires
clarification

In previous versions, the description of the time delays that accompany the execution of a backup
command was unclear in the AccuRev Administrator’s Guide. This description has been changed in
the current release to read as follows: "The backup command makes a copy of the AccuRev metadata.
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During backup command execution, clients can continue to work. Only transactions that are complete
at the time the backup command is invoked are included in the metadata backup. The backup may take
a few seconds or a few minutes, depending on the amount of metadata on your system. After running
the backup, you can make a complete copy of the file storage area (the storage directory tree), without
worrying about synchronization or time-skew."

24439 -- Clarify the use of the -s -t options for the update command

The CLI documentation now describes how to use the -s and -t options with the update command to
inspect a stream for changes that occurred within a specified range of transactions.

25346 -- Document that the remove sessions command must be run on the master server

In previous releases, the CLI documentation did not mention that the remove sessions command must
be run on the master server in order to work. In a master/replica environment, issuing the command
accurev remove sessions against an account with a logged-in session from a replica does not remove
the sessions if it is run from the replica server. The session is removed only if you issue the command
against the master server.

27035, 27691 -- New: CLI support for diffing overlapped elements

AccuRev 5.6 introduced new Diff Against options in the AccuRev GUI to help identify and resolve
conflicts that result in an (overlap) status -- Diff Against Overlapping Changes, which provided two
options:

= Mine - This Overlapping Changes option diffs the workspace or stream version against the
common ancestor in the backing stream. This option identifies the changes in the workspace or
stream that did not come from the backing stream; this option is the equivalent of diffing against
the last version that you merged with.

» Theirs - This Overlapping Changes option allows you to see only the changes added to the
backing stream since the last time you merged with the backing stream. This option is useful for
identifying the changes to the backing stream that caused the overlap condition.

These Diff Against options were subsequently supported in the AccuRev CLI but were never
documented. New --mine and --theirs options that can be used alone or in combination with the -a and
-v options of the diff command are now documented in the AccuRev CLI User’s Guide and CLI help.

28410 -- Correct syntax for db-admin property in the maintain command

The Administrator’s Guide and command line help for the maintain server_properties command
showed that the db-admin property was optional when running maintain server_properties update.
In fact, the db-admin property is required if you specify the update option. In addition, this property
was referred to as db-admin-role in the command line help, and db-admin in the Administrator’s
Guide. Both of these errors are corrected in the current release.

29123 -- Document the fileModTime xml output -x switch

The CLI documentation now describes the fileModTime value that is returned in the output of an
accurev show -fix wspaces CLI command. The fileModTime value represents the timestamp of the
last time the workspace was updated, converted to UNIX timestamp format.

29430 -- Edit the documentation for the incl, incldo and excl commands

The documentation for the incl, incldo and excl commands now includes the word "rule" in the title
line so as to return these commands when a user searches for the word "rules" in the documentation.
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29670 -- Clarification of the use of the <depot> parameter for Isrules and mkrules

In previous releases, the requirement for the use of the <depot> parameter in the Isrules and mkrules
commands was not made clear. The CLI usage documentation and examples have been revised.

29773 -- XML issuediff and issuelist commands are not documented

In previous releases, the XML issuediff and issuelist commands were not documented. The issuediff
and issuelist XML commands are now documented in the CLI User’s Guide and CLI help.

29823 -- Need to update how to run acgui in debug mode

The "Running the AccuRev GUI in debug mode" section of the On-Line Help documentation has been
updated to include changes when running acgui in debug mode in AccuRev version 5.6 and later.

30948 -- Cross-references for the login command improved

The cross-references in the See Also section for the login command have been improved to include
additional related commands and documentation.

30960 -- setproperty and rmproperty documentation clarified

The documentation for the setproperty and rmproperty CLI commands has been clarified with
respect to modifications required to the server_admin_trig trigger. In addition, the reference
information for the server_admin_trig trigger has been updated to include information on
propertyName, propertyValue, streamName, and propertyKind parameters.

31504 -- New: -t option for cpkdescribe
The new -t option for the cpkdescribe command is documented in the CLI User’s Guide and CLI help.
31956 -- %USERPROFILE% misspelled in AccuRev Technical Notes

In previous versions of the AccuRev Technical Notes, the %USERPROFILE% variable described in
.acignore topics was spelled as %USER_PROFILE%. This problem has been corrected in the current
release.

32220 -- Clarification regarding the creation of versions

A passage in the user documentation asserted that new versions are created "...when content changes."
In fact, new versions are created during operations --like keep, add, merge, and rename-- even if the
file’s content does not change.

32255 -- Typo corrected in Getting Started with AccuRev

A typographical error in Chapter 1, Day-to-Day Usage of AccuRev in Getting Started with AccuRev
was corrected.

Changes in AccuRev Web Ul Release 6.1

AccuRev Web Ul Release 6.1 includes the following:
32961 -- Use AccuRev Plug-In for Crucible 3.0 or later

The integration between the AccuRev Web Ul and Crucible is only available for versions of Crucible
prior to 3.0. If, however, you are using Crucible 3.0 or later, you can add AccuRev contents to a
Crucible review by using the AccuRev Plug-In for Atlassian Crucible, which is available here:

http://supportline.microfocus.com/websync/productupdatessearch.aspx
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Known Issues

This section describes known issues in AccuRev and in the AccuRev Web Ul. Refer to the Known Issues
sections from previous releases for other known problems and workarounds.

Known Issues in AccuRev
21829 -- Chrome browsers and Help

Recent Chrome browsers do not work with on-line Help systems (see http://code.google.com/
p/chromium/issues/detai 1?id=47416). A security enhancement to Chrome browsers in June
2010 has caused problems in several on-line Help systems. In AccuRev’s case, the left-hand
navigation pane is blank, and it is impossible to display the Table of Contents, Search, and Glossary
tabs. Possible workarounds include:

= rolling back to an older version of Chrome

= using a different browser

= disabling the security feature in the AccuRev preferences
= disabling the security feature system-wide

Google has provided a command line switch to disable this new security feature. You can try disabling
this feature just for AccuRev Help, by using the following procedure:

1. Inthe AccuRev GUI, go to Tools, Preferences

2. Inthe On-line Help Browser field, specify the start-up command line for Chrome with the “--
allow-file-access-from-files” argument (Windows XP and 7 examples shown):

Windows XP:

"C:\Documents and Settings\<user>\Local Settings\Application
Data\Google\Chrome\Application\chrome.exe"
--allow-file-access-from-files "%1"

Windows 7:

"C:\Users\<user>\AppData\local\Google\Chrome\Application\chrome.exe"
--allow-file-access-from-files "%1"

If this does not work for your installation, another option is to try using this switch as the default for all
instance of Chrome on your system. The following example shows how to use this fix in Windows.
Adjust appropriately for other operating systems. The following procedure assumes that you have
Chrome set as your default .htm/.html browser:

1. Open Windows Explorer.

2. Navigate to Tools => Folder Options => File Types
3. Select "HTM" or "HTML", then click Advanced.

4. Select Open, then click Edit...
5

In the "Application used to perform action:" field, you should see a line similar to:

AccuRev® Installation and Release Notes 79



Windows XP:

"C:\Documents and Settings\<user>\Local Settings\Application
Data\Google\Chrome\Application\chrome.exe" -- "%1"

Windows 7:

""C:\Users\<user>\AppData\local\Google\Chrome\Application\chrome.exe"
-— "%l

6. Replace the empty "--" with "--allow-file-access-from-files":

Windows XP:

"C:\Documents and Settings\<user>\Local Settings\Application
Data\Google\Chrome\Application\chrome.exe"
--allow-Tile-access-from-files "%1"

Windows 7:

""C:\Users\<user>\AppData\local\Google\Chrome\Application\chrome.exe"
--allow-file-access-from-files "%1"

7. Click OK, OK, and Close to save your changes and exit out of the dialogs.

Of course, if this line has already been customized at your site, you will need to adjust the above
instructions as needed.

Also, note that implementing this fix will disable a security change introduced with Chrome, so the
security policies of some organizations may prohibit them from doing this.

23564 — Delete preferences.xml when switching locales

If you switch between the Japanese and English versions of AccuRev, you must delete the
preferences.xml file located in <homeDirectory>/ .accurev. When switching between locales, your
preferences file can be left in the state where there is no UTF-8 header, but there are Japanese
characters which cause Exceptions when you try to login to AccuRev.

24248 — Depot names must be ASCII

Only stream, workspace, and reference tree hames can be non-ASCII. Depot names must be ACSCII.

29960 -- Viewing PDF through the online help disables help viewing controls

If you load the online help and click on the PDF button, you can no longer browse HTML content
using the Contents, Index, or Search tabs in the left hand pane. You need to close and re-open the
online help. This problem affects the online help when viewed using Firefox and Internet Explorer.

To work around this issue, configure PDFs to open in a separate Adobe reader window:
1. Open Adobe Reader.

2. Navigate to Edit > Preferences > Internet.

3. Uncheck "Display PDF in browser".

4. Click OK and exit Adobe Reader.

For Firefox, you also need to perform the following procedure:
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1. Open Firefox and navigate to Tools > Options > Applications.
2. Scroll down to "Portable Document Format (PDF)".

3. Ensure that "Preview in Firefox™ is NOT selected. Any other option of your choosing is
acceptable.

4. Click OK and exit all instances of Firefox.

After performing these procedures, clicking the PDF button in the AccuRev Help browser should
either display the PDF in a different window, or display a dialog asking how you want to display the
file.

30567 -- Changes to 6.0 XML to accommodate issue variants and multiple segments

The XML generated by AccuRev changed to support issue variants and elements with multiple
segments as part of the improvements to change packages. If you are using change packages, or if you
have issue variants or elements with multiple segments, you should be aware of the possible impact the
XML can have on AccuRev Bridges, scripts, and triggers.

= XML input for cpkdescribe and cpkelems. In previous releases, the <stream1> tag provided
the depot context for the cpkdescribe and cpkelems commands (even if the proper way to specify
the depot was to use the <depot> tag). In AccuRev 6.0, the <stream1> tag will provide the these
commands with the --from_stream context.

Even though neither the <stream1> tag nor --from_stream option is required to run the
cpkdescribe and cpkelems commands, they are required in order to get accurate element versions
for an issue or set of issues in a stream. These commands will return information for all issue
variants when the -—from_stream option is not present. See the CLI documentation for more
information on the --from_stream option.

= XML output for cpkdescribe. The XML output for the cpkdescribe command now includes
variant_num= attributes in the <issue_num> tag. This attribute provides grouping among element
versions that span multiple issue variants. Scripts or the XML parser do not need to parse this
attribute as long as a) either the <stream1> tag or --from_stream option is provided and b) the
script or XML parser has the ability to parse multiple <issue_num> tags in the output.

In addition, the XML output for the cpkdescribe may describe multiple version segments for the
same element when multi-segment change packages are present. The script or XML parser needs
to be able to parse multiple <element> tags with the same id= attributes within the <elements>
tag.

= XML output for issuelist. The XML output for the issuelist command now includes a
multiple_variants= attribute on the <issue> tag with values of true or false. This attribute
will be present in the XML only when it is true; that is, when the stream contains more than one
variant for the same issue. Because of this, the script or XML parser needs to be able to parse or
ignore this attribute.

30697 -- Install issues on Mac OS X running Java 1.7

The third-party installation software used by AccuRev does not support installations on Mac OS X
running Java 1.7. This issue causes the AccuRev client installation to fail in this environment.

To work around this problem, on the Mac on which you wish to install the AccuRev client:
1. Uninstall Java 1.7.
2. Install Java 1.6.
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3. Install AccuRev.
4. Install Java 1.7.

30715 -- Some screen shots are out of date

Some of the screen shots of the AccuRev GUI were not updated for the current release. In particular,
you might notice that the color of the folders and issues displayed in \ersion Browser screen shots do
not match the colors in the AccuRev GUI.

33129 -- Additional GitCentric configuration required when AccURev 6.1 with SSL

If you are using a current version of GitCentric (2013.3, 2013.2, or 2013.1) with AccuRev 6.1 and you
have enabled the Secure Sockets Layer (SSL) protocol on the AccuRev server, you need to take the
following additional steps to continue using GitCentric in an SSL-enabled environment. Completing
this procedure ensures that the SSL certificates are in a directory that is recognized by the bridge.

1. Add the following lines to whatever script you use to start Tomcat (for example, catalina.sh):

# Copy AccuRev certificates from home directory to temp/.accurev

mkdir -p $CATALINA_TMPDIR/.accurev

rm $CATALINA_TMPDIR/ .accurev/*.crt

cp <GitCentric Install Path>/certs/*._crt $CATALINA_TMPDIR/ .accurev

where <Gitcentric Install Patt> is the full path to the GitCentric installation directory.

2. Obtain an SSL certificate from the AccuRev server by running the accurev get_certificate
command from an AccuRev client on the machine on which GitCentric is installed.

3. Execute the following:

mkdir <GitCentric Install Path>/site/certs
cp ~/.accurev/*crt <GitCentric Install Path>/certs

4. Restart the Tomcat server.

33428 -- Use chws for workspaces created on bind mounts

(UNIX/Linux only) If you create a workspace on a bind mount, the workspace storage and location will
differ. If you are working in the mounted directory, AccuRev will not display newly created elements
in the GUI, and the stat command will display errors like **Bad element name™ and “Element not
found in workspace' -- even though the elements exist in the workspace.

To work around this problem, you need to use the chws command to change the workspace location to
be the same as its storage. For example:

1. Run accurev show -fv wspaces to clearly identify the location and storage paths associated with
the workspace. In the output, the Location is the bind mount, and the Storage is the workspace’s
physical storage. For example:

Workspace Location Storage Host Stream#
newWsS /home/shankin/ws/W1 /export/home/shankin/ws/W1 shankin-vm64 10 13 13 1 0O
2. Next, cd to the workspace Storage path. For example:

cd /export/home/shankin/ws/W1

3. Finally, run the chws command using the -w and -I . (el period) options to change the location of
the workspace. For example:

accurev chws -w -1 .
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Note that after you perform this procedure, AccuRev will still default the workspace location to the
bind mount the next time you create a workspace (/home/shankin/ws/, for example). Once you
specify the path for the new workspace as the storage location (/export/home/shankin/ws/, for
example), however, AccuRev will remember it and no subsequent manual intervention is required.

33457 -- Client connection lost on Windows 2003 using SSL

(Windows 2003 only) AccuRev clients receive the following error when attempting to connect to an
AccuRev server for which SSL has been enabled:

Network Error - 6: Connection lost while receiving data.
To work around this limitation:

1. Execute the accurev enable_ssl command.

2. Review and accept the certificate when prompted.

Once the certificate has been installed, the AccuRev client will be able to connect to the AccuRev
server without any additional action.

Known Issues in the AccuRev Web Ul

The 6.1 release of the AccuRev Web Ul has the following known issues:

(Firefox on Linux only) If multiple objects are selected in the workflow diagram, right-clicking one of
the objects to display its shortcut menu does not properly reset the selection to that object. As a result,
the Edit choice is disabled when the shortcut menu appears. To work around this issue, clear the group
selection by clicking the diagram background. Shortcut menus for any object you select will then
appear as expected.

The URL links provided in the Version Browser, History Browser, and Annotate tool are not
permanent. Permanent URLSs always refer to the same version of an element, and contain references to
both the element-1D and version number.

(Internet Explorer only) Text and log fields might exhibit some of the following issues:
»  Formatting for bulleted and ordered lists is not always preserved.
= The Enter key creates two lines. (Tip: Use Shift+Enter to create single line spacing.)

= Ifatextor log field has been defined in the AccuRev Schema as read-only based on certain
conditions (setting an issue’s status to Closed, for example), it is sometimes possible to edit the
field and save the changes.

Issues with text and log fields will be addressed once the next Google Web Toolkit is available.

22670 — Opening Web Ul on Mac OS X in Firefox or Chrome

If you are using the AccuRev GUI running on Mac OS X and you open an issue in the
Web Ul, you might experience the following if your browser is Firefox or Chrome:

= |f the web browser is running, it displays an error message indicating that it cannot open another
browser instance; the AccuRev Web Ul is not displayed

= If the web browser is not running, your default browser opens; the AccuRev Web Ul is displayed
on a new tab in that browser session
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33678 — Tomcat 6 customizations must be merged after upgrading to AccuRev 6.1.1

AccuRev 6.1.1 and AccuRev 6.1 install a new version of the Tomcat web server, Tomcat 7; previous
versions of AccuRev (AccuRev 6.0 and earlier) used Tomcat 6. Tomcat is used by the AccuRev Web
Ul.

Depending on your upgrade path and whether or not you customized your existing Tomcat web server,
you might have to perform additional steps in order for your Tomcat web server to operate as it did
before upgrading to AccuRev 6.1.1, as summarized in the following table:

Table 1. Customizing Tomcat after Upgrading to AccuRev 6.1.1

Current Did You
AccuRev Customize Are Additional Steps Required?
\ersion Tomcat?
6.1 No No.
Yes No.
6.0 or earlier No No.
Yes Yes. If you made any changes to your Tomcat 6 web server, you need to merge

those changes with your Tomcat 7 installation. For example, if you modified
server.xml, you need to reflect those modifications in the server.xml file that
is installed with Tomcat 7 -- the format of the Tomcat 6 server.xml file is
incompatible with Tomcat 7.

To help you with this process, AccuRev renames your
<AccuRev_install>\WebUI\tomcat directory to
<AccuRev_install>\WebUI\tomcat.old when you upgrade to AccuRev 6.1.1.

Source Code Availability

AccuRev uses third-party code in the development of some of its features. In accordance with open-source
policy, this section describes what code is used. Third-party source code used by AccuRev is available
here:

http://www.accurev.com/downloads/gpl-Igpl-source-code

Diff and Merge

AccuRev acdiff and acdiff3 programs implement text-file comparison and merging operations. To
download the source code used by acdiff and acdiff3, click this link:

http://www.accurev.com/download/open-source/acdiff_source.zip

Character Set Encoding Conversions

AccuRev uses GNU libiconv for character set encoding conversions. To download the libiconv source
code, click this link:

http://www.accurev.com/download/open-source/accurev_gettext_iconv.zip

Rich Text Formatting
AccuRev uses SHEF for rich text formatting. To download the SHEF source code, click this link:
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http://www.accurev.com/download/open-source/shef_accurev_source.zip

Reports

The AccuRev Web Ul uses Open Flash Chart 2 for reports. To download the Open Flash Chart 2 source
code, click this link:

http://www.accurev.com/download/open-source/open-flash-chart-2-Lug-Wyrm-Charmer.zip

Version Browser

AccuRev uses JGraphT to create graphs in the Version Browser. To download the JGraphT source code,
click this link:

http://www.accurev.com/download/open-source/jgrapht-0.8.3.zip
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AccuRev 6.0 Release Notes

This chapter describes changes and other information related to AccuRev Release 6.0. Changes to the
AccuRev Web User Interface (Web Ul) are described in a separate section in this chapter.

Deprecated Features

This section describes features that are deprecated in AccuRev 6.0. These features will not be supported in
a future release. See the Deprecated Features sections for previous AccuRev releases for information on
other deprecated features.

The following features are deprecated in AccuRev 6.0 and will not be supported in a future release:

= Transaction-level integration. This has been one of two integrations available between AccuRev
SCM and the AccuWork issue tracking system. Transaction-level integration (as described in Chapter
10, AccuRev Triggers in the AccuRev Administrator’s Guide) will not be supported after this release.
Please use change package-level integration, as described in the Schema Editor chapter of the On-Line
Help Guide. Any scripts that make use of transaction-level integration should be updated so they will
not break when support for transaction-level integration is removed.

» The ":<issue-number>" argument for the revert command. Due to the introduction of multi-
segments in AccuRev 6.0, this argument is no longer necessary and is ignored if invoked. Please
update any scripts that use this argument so they will not break when it is removed.

Changes in Release 6.0.2

AccuRev Release 6.0.2 is a patch release for Version 6.0 that is fully compatible with all 6.x versions.
However, AccuRev recommends that users on Windows platforms with workspaces located in a path that
was mounted using a net use, net share, or subst command upgrade both the AccuRev server and clients
to Version 6.0.2.

AccuRev Release 6.0.2 addresses the following issues:
29918 -- Problems using file shares or substituted drives on Windows platforms

In previous releases, users encountered problems when using file shares or substituted drives on
Windows platforms. These problems have been corrected in Release 6.0.2.

31023, 31581, 31700 -- Remove (red X) is enabled erroneously for Closed issues in
AccuWork

In previous releases, the Remove (red X) option was active when a user opened an AccuWork issue
with a status of Closed, even if the schema editor specified that the Changes tab was set to read-only.
This problem has been corrected in Release 6.0.2.

31519 -- Promote to an issue fails after another user has merged and promoted to a
different issue

In previous releases, when a user attempted to promote against an AccuWork issue that was previously
used for a promote from the same workspace, but another user had performed a file merge and then
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promoted to a different issue in the interim, the change package could not be merged and the promote
operation failed. This problem has been corrected in Release 6.0.2.

31570 -- A replica sync fails after upgrading a replica to 6.x

In previous releases, upgrading a replica to 6.0 or 6.0.1 and then running a replica sync command
produced the following error:

"network error - Connection lost while receiving data. Error 6 - acp.c:84 - Communi-
cations failure™.

This problem has been corrected in Release 6.0.2.
31717 -- Performance improvements implemented for the archive command

In previous releases, running an accurev archive command was a time-consuming process. The
performance of the archive command has been significantly improved in Release 6.0.2.

31954 -- Upgrading from any AccuRev version between 4.x and 5.5 to version 6.x loses
change package information

If you used change packages in AccuRev version 4.x through version 5.5, upgrading directly to
AccuRev 6.0 or 6.0.1 resulted in the loss of change package information. This problem has been
corrected in Release 6.0.2.

31988 -- The performance of the keep command degrades if issue 0 contains a large
number of files

In previous releases, the performance of the keep command degraded when issue 0 contained a large
number (thousands) of files. The performance of the keep command under these circumstances has
been significantly improved in Release 6.0.2.

31990 -- Upgrade process degrades when the installation contains a large number of
depots

In previous releases, the performance of the maintain dbupgrade command degraded and produced
an "out of shared memory" error when an installation contained a large number of depots. To address
this issue, a new maintain dbupgrade option, called "--auto_commit", has been added.

When this option is off, maintain dbupgrade does not commit changes to depots until all depots have
been upgraded. If a depot reports an error, the entire transaction is rolled back and no depots are
upgraded.

When this option is on, maintain dbupgrade commits the changes to each depot immediately and if a
depot reports an error, only changes to that depot are rolled back.

By default, the --auto_commit option is off.

Changes in Release 6.0.1

AccuRev Release 6.0.1 is a patch release for Version 6.0 that addresses the following issues:
28831 -- Support for non-XML characters in AccuWork schema

In previous releases, the AccuWork schema did not support non-XML characters such as ampersand
(&) and forward slash (/) as values for fields with type Choose. This problem has been corrected in
Release 6.0.1.
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31104 -- required jar file included in AccuRev Diff tool

In previous releases, the executable for the AccuRev Diff tool, acdiffgui.exe, did not list all of the jar
files needed to run the AccuRev Diff tool from within AccuRev Plug-In for Visual Studio PE. This
prevented users of AccuRev Plug-In from using the AccuRev Diff and Merge tools. This problem has
been corrected in Release 6.0.1.

31130 -- Version Browser can hang when switching tabs

In the previous release, switching between the Streams & Workspaces and Issues tabs in the Version
Browser could cause AccuRev to hang if an object (a stream, workspace, or issue) was selected in the
tab. This problem has been corrected in Release 6.0.1.

31149 -- Issue display in Version Browser corrected

In the previous release, the issues displayed on version boxes in the Version Browser were not always
correct. This problem has been corrected in Release 6.0.1.

31150 -- Performance improved for cpkdescribe and issuelist commands

In the previous release, the performance of the cpkdescribe and issuelist commands suffered when
they encountered a file version whose history contained numerous patches, each of which contained
additional patches. AccuRev has changed the way such nested patches are managed, correcting this
issue in Release 6.0.1.

31174 -- Legacy data from AccuRev 3.x migrates correctly

In AccuRev 3.x, directory elements were not created with a real version. That issue, which was
addressed in a previous release, prevented the successful migration of AccuRev 3.x data to AccuRev
6.0. This problem has been corrected in Release 6.0.1.

31175 -- Unaffiliated changes now listed in transaction order

The issuelist command XML output now lists unaffiliated version segments in ascending transactional
order, by head version of the unaffiliated segment. This allows for proper grouping of changes in the
AccuRev GUI.

Changes in AccuRev Release 6.0

AccuRev Release 6.0 includes the following new features and bug fixes:
17640, 19144, 19723 -- Enhancements to Show Diff by Files

There have been several enhancements and fixes to the Show Diff by Files feature and the Stream Diff
(Files) tab:

= In previous releases, right-clicking the destination stream version displayed the context menu for
the source stream version, and vice versa; in addition, actions selected from the context menu were
performed on the opposite version of the one you selected (on the source if you selected the
destination, for example). The context menus and actions are now performed on the selected
version.

= You can now open a file that is in only one of the streams that you are diffing. In previous releases,
the Open menu choice was unavailable in this situation.

= The value in the Version #1/Version #2 column used to be blank for those files that were in only
one of the streams that you were diffing. The value in the Version #1/Version #2 field now
displays a value in this situation.
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18924 -- Enhanced message when twin elements are encountered

In previous releases, AccuRev displayed an error message like the following when it encountered a
twin during a cross-promote operation:

Another element with the same name already exists in parent stream: eid 123456
This message has been enhanced to include the full element name instead of its EID, and the reference

to the parent stream has been replaced with destination stream. In addition, the Change Palette now
includes an Id column for the display of the source file’s EID.

19304 -- ACCUREV_USE_MOD_TIME environment variable does not preserve the
timestamp for cross-linked elements

(Windows only) In previous releases, setting ACCUREV_USE_MODE_TIME=1 did not preserve the
timestamps for cross-linked elements. This problem has been corrected in the current release.

21661 -- ACCUREV_IGNORE_ELEMS treating (modified) elements as external

In previous releases, the ACCUREV_IGNORE_ELEMS environment variable treated elements with a
(modified) status as external, causing them to be ignored. This occurred when the workspace directory
associated with the elements was specified in an ignore pattern (*/my_files, for example) and the file
(#/my_fFiles/readme.txt, for example) was modified but not kept. This problem has been corrected in

the current release.

Note: The ACCUREV_IGNORE_ELEMS environment variable was deprecated in AccuRev 5.7 and
will not be supported in a future release.

23353 -- Changes to file type were not reflected by update

In previous releases, AccuRev did not update files when the only change to a file was its type. For
example, if UserA changed a file type from text to ptext and promoted the file, the file’s type would
still be text after UserB updated her workspace.

27829 -- SAException(7): ERROR thrown on replica servers

In previous releases, multiple simultaneous login requests on the AccuRev replica server could create a
race condition, resulting in AccuRev throwing the following error:

S/_\ExceEtion(7): ERROR: duplicate key value violates unique constraint "‘user_ses-
sion_pkey"

This problem has been corrected in the current release.
28001 -- Group names are repeated by show -u <username> groups command

In previous releases, AccuRev repeated group names for users in nested groups when executing the
show -u <wsername> groups command. For example, if you created a groupA with userA, created
groupB, and then added both groupB and userA to groupA, AccuRev would return groupA twice when
running show -u userA groups. This problem has been corrected in the current release.

28086 -- change package improvements

Change packages are now easier to use, allowing you to work in a natural manner without the necessity
of manual rules and procedures. AccuRev has always been good at showing you where your files are
and how your project is progressing, but with Release 6.0, improvements in the following areas now
make it easier to manipulate the elements involved in those projects.

= [Issue Dependencies -- AccuRev now automatically keeps track of changes even when the same
element has versions from two different issues. It is no longer necessary to ensure that all changes
for one issue are complete before promoting changes for a different issue.
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= Tracking Issues -- Tracking issues are still available if you wish to use them, but they are no longer
required when you patch an issue from one stream to another (see “Enhanced Change Palette
Behavior” below).

= Incomplete Change Packages and Unaffiliated Changes — AccuRev has always been able to alert
you to files that are missing from a change package, but now it is also able to alert you to missing
versions of a file. This means that you will see far fewer instances of “Unaffiliated Changes”
(versions of files that cannot be associated with an issue in the current stream). Also, you can now
send all Unaffiliated Changes to an issue with a single mouse click, making it easier to clean up
your streams.

As part of the improvements to change packages, the Change Palette has changed in the following
ways:

* You no longer need to use the Change Palette for simple cross-promotes for issues. You can simply
drag & drop issues from a dynamic stream to the destination stream. If there are no conflicts, the
operation completes immediately. AccuRev only brings up the Change Palette if there is a conflict
that requires your intervention. Note that files cannot be cross-promoted in this manner.

= There is now an enhanced Change Palette mode for issues. This mode provides functionality for
efficiently identifying and dealing with conflicts and issue dependencies, and then promoting the
issues into the destination stream.

28177 -- Merging large ptext files hangs AccuRev

(Windows only) In previous releases, merging a large ptext file (62kb or larger) could hang AccuRev
when the file was being read from the AccuRev repository (not the workspace). This hang occurred
during execution of the cat command, which AccuRev calls during the merge process. This issue has
been corrected in the current release.

28324 -- New: set stream background color

You can use a new style property for the setproperty command to set the background color for streams
and workspaces using the hex value for any web-safe color. For example, this command sets the
background color of the nightly stream to red:

accurev setproperty -s nightly -r style "<style><color><background-color>#FF0000</
background-color></color></style>"

Note that the value for the style property is expressed as XML, which must be escaped using quotation
marks. See the CLI User’s Guide or command line help for more information.

Note: The name of the style property changed to streamStyle in AccuRev 6.1. See 30757, 31987 --
New: Features to Support Continuous Integration on page 72 for more information.

28326 -- New: Vertical stream layout

In previous releases, streams in the AccuRev GUI were displayed using a horizontal layout, with the
root stream on the left and the child streams laid out in single rows from left to right. In AccuRev 6.0,
you can now display streams vertically. The vertical layout can make many stream displays more
compact and easier to navigate. Vertical layout is now the AccuRev default, but you can change this
setting on the StreamBrowser tab of the Preferences dialog box (Tools > Preferences).

28328 -- New: File Browser enhancements

The File Browser for both streams and workspaces has benefited from numerous enhancements, most
notably new Explorer, Outgoing Changes, Incoming Changes, and Conflicts modes that make it easy
to see your changes, and the changes of others, at a glance.
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28364 -- Specifying invalid stream name in show stream_rules crashes the server
In previous releases, the show stream_rules command crashed the AccuRev Server if you
= Specified a non-existent stream name
= Specified a stream number (using the -p <depot> option)

This problem has been corrected in the current release, and AccuRev now displays a message
informing you that the stream name is invalid.

28378 -- maintain dbupgrade no longer fails when encountering errors in encoded fields

In previous releases, the maintain dbupgrade command would sometimes fail when it encountered
errors in text fields that were the result of saving a given issue record in different locales. AccuRev
added a UTF-8 character type encoding header for the current locale to every text field each time the
record was saved, which ultimately caused the field to exceed limits that could be managed by the
maintain dbupgrade command. This problem has been addressed in the current release, and maintain
dbupgrade no longer fails in this situation. (The problem of adding a new UTF-8 encoding header each
time a record is saved was addressed in a previous release.)

28437 -- Improved error message for invalid diff -v -v command

AccuRev now displays an error message informing you that using two lowercase -v options with the
diff command (accurev diff -v 33/16 -v 1/6 readme.txt, for example) is invalid.

28458 -- Revert and purge operations clear execute bit

(Mac OS X and Linux only) In previous releases, revert and purge operations incorrectly cleared the
file’s execute bit. This problem has been corrected in the current release.

28875 -- New: Version Browser enhancements

The Version Browser has been enhanced in several ways, both to support the latest change package
improvements, as well as to make it generally easier to use.

28888 -- New: Show Current Change Package control in History Browser

A new control, the Show Current Change Package check box, has been added to the Active
Transactions tab in the History Browser. When unchecked (the default), the lower pane shows the state
of the change package as it was at the time of the selected transaction. However, when the Show
Current Change Package check box is checked, AccuRev displays the current state of the change
package, regardless of the time of the selected transaction. This feature allows you to easily see any
changes that occurred after a given transaction.

29059 -- hist command can fail when closing stdin
In previous releases, the hist command could sometimes fail with the following error when closing
stdin:
Error 1 - sys.c:185 - failure closing O - System Error: 6 The handle is invalid

This could occur only in frameworks that allow a created process to be reused, as is the case with the
.NetProcess class, for example. This problem has been corrected in the current release.

29194 -- Improved error message for client/server mismatches

In previous releases, if the versions of the AccuRev Client and AccuRev Server were incompatible,
AccuRev displayed a message telling you that the client was running the "wrong" version of AccuRev.
The message now tells you whether the incompatible Client is running a version of AccuRev that is
older or newer than that of the Server.
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29267 -- files command returns a non-zero value when file is not found

In previous releases, if the files command (files foo.txt, for example) did not find a file, it returned
a 0. It now returns a 1.

29325 -- Typographical errors in the AccuRev installer
Typographical errors in the AccuRev installer were fixed in the current release.
29352 -- Creating public stream favorites are unavailable

In previous releases, stream favorites created as public stream favorites could not be displayed by other
users of the same depot. This problem has been corrected in the current release.

29884 -- Stream Explorer and Workspace Explorer sort in case-insensitive order

In previous releases, the Stream Explorer and Workspace Explorer sorted in a case-sensitive order
(uppercase names appeared before lowercase names, so Phoenix would appear before nimbus, for
example), while the display in the Details pane was sorted in case-insensitive order (Phoenix appeared
after nimbus, for example). This problem has been corrected in the current release, and both the
Explorer and Details panes sort in case-insensitive order.

30280 -- mergelist command performance

In AccuRev 5.7, the performance of the mergelist command degraded significantly. This problem has
been corrected in the current release, and performance now exceeds that of AccuRev 5.6.2 and earlier.

Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 6.0 documentation.

25505 -- include cpkadd and cpkremove in description of server_preop_trig

The table identifying commands fired by the server_preop_trig trigger now includes cpkadd and
cpkremove.

28619 -- Document getproperty and rmproperty for server_admin_trig

The getproperty and rmproperty commands were not included in the list of commands that are fired
by the server_admin_trig trigger. This problem has been corrected in the current release.

29430 -- "rule" added to excl, incl, and incldo command descriptions

The word "rule"was added to exlc, incl, and incldo command descriptions in the CLI User’s Guide to
make them easier to locate in searches of the documentation.

29469 -- Bookmarks missing in the Installation and Release Notes

The PDF for the 5.7 Installation and Release Notes was missing bookmarks. This problem has been
corrected for the current release.

29488 -- Clarification for CLI eacl command

The usage notes for the eacl command clarify what information is returned if no privilege changes are
specified.

29591, 28080 -- Typographical errors in the On-Line Help Guide, CLI User’s Guide

Reported typographical errors in the On-Line Help Guide and the CLI User’ Guide were corrected.
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29764 -- Incorrect page numbers in some cross-references

The previous release of the Installation and Release Notes included some cross-references with
incorrect page numbers; the hyperlinks behaved correctly even though the page number itself failed to
update when the book was generated. This problem has been corrected in the current release.

29832 -- Clarification in dragging and dropping a default group

In previous releases, the documentation stated that dragging a default group to a workspace performed
a Send to Workspace operation. In fact, this action performs a Send to Change Palette operation. The
documentation has been updated to correct this error.

29859 -- Remove references to (pending) status

Previous releases of the documentation made reference to a (pending) status instead of speaking more
generally about modified elements in the workspace that were waiting for, or pending, promotion. This
problem has been corrrected in the current release.

29870 -- Byte Order Mark (BOM) field documented

The Merge view toolbar includes a conditional BOM field that appears when the Character Encoding
field is set to Unicode (UTF-8). This field was not documented in previous releases; this problem has
been corrected in the current release.

29978 -- Document -fv -fvx for show wspaces

In previous releases, the -v option for the show wspaces command was not documented. The
documentation now notes that this option adds a Loc (location) column to output.

30265 -- MAC OS security setting required to install AccuRev

The Installation and Release Notes now note that if you are installing the AccuRev Client on Mac
0OS X 10.7.5 or later, you must set the Gatekeeper feature to allow applications to be downloaded from
Anywhere.

Changes in AccuRev Web Ul Release 6.0

AccuRev Web Ul Release 6.0 includes the following:
Stream colors supported in the Web Ul StreamBrowser

Stream background colors created using the new style property for the setproperty command are
supported in the AccuRev Web Ul. See 28324 -- New: set stream background color on page 91 for
more information.
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